
Sprint Mobile Broadband

USB Modem

by Sierra Wireless

AirCard
®

595U

www.sprint.com

© 2007 Sprint Nextel. All rights reserved. SPRINT and other trademarks 
are trademarks of Sprint Nextel.

www.sprint.com


Table of Contents

Welcome to Sprint  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . i

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ii

Section 1: Basics of Your USB Modem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

1A. Introducing the Sprint Mobile Broadband USB Modem . . . . . . . . . . . . . . . . . . . 3

Your Sprint Mobile Broadband USB Modem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

CDMA Networks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

One Touch Activation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Package Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Care and Maintenance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

About This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

1B. Getting Started With Your USB Modem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

The USB Modem Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

1C. Getting Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12

Visiting the Sprint Web Site  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Contacting Sprint Customer Service  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Section 2: Installing the USB Modem on a Windows Computer  . . . . . . . . . . . . . . . . . .15

2A. Installing the Software on a Windows Computer  . . . . . . . . . . . . . . . . . . . . . . .17

Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

2B. Inserting and Removing the USB Modem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .21

Inserting the USB Modem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Removing the USB Modem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

2C. Setting Up Service (Windows)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

Activating and Using Sprint Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Preactivated USB Modem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Non-preactivated USB Modem: One Touch Activation . . . . . . . . . . . . . . . . . . . . . . 25

Non-preactivated USB Modem: Activation Wizard  . . . . . . . . . . . . . . . . . . . . . . . . . 25

Data Provisioning (IOTA)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27



Section 3: Using the USB Modem on a Windows Computer  . . . . . . . . . . . . . . . . . . . . .29

3A. Your USB Modem: The Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .31

Sprint Connection Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Starting Sprint Connection Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Starting Sprint Connection Manager Automatically  . . . . . . . . . . . . . . . . . . . . . . . . 33

Sprint Connection Manager Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Connection States (Mobile Broadband Window)  . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

GPS Status (GPS Receiver Window)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

System Tray Connection States . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Determining the Type of Coverage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Attaching an External Antenna . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Sprint Location Services  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Powering the USB Modem On and Off  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Controlling the Sprint Connection Manager Window . . . . . . . . . . . . . . . . . . . . . . . 46

Launching a Sprint Power Vision or Sprint Vision Connection  . . . . . . . . . . . . . . . 50

Viewing the Amount of Data Transferred  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Ending a Connection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Displaying Your Phone Number . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Accessing Links  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Uninstalling the Sprint Connection Manager Software  . . . . . . . . . . . . . . . . . . . . . 59

3B. Menu Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .60

Sprint Connection Manager Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

System Tray Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

3C. Changing Sprint Connection Manager Settings . . . . . . . . . . . . . . . . . . . . . . . . .64

Settings Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

General Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Sprint Mobile Broadband Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Sprint Location Services Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

3D. Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .74

Viewing the Connection History  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Viewing Alerts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

Running Diagnostics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Updating the Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

About Sprint Mobile Broadband  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80



3E. Frequently Asked Questions (Windows)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .81

What is Sprint Connection Manager?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

If the connection is “always on,” am I always being billed? . . . . . . . . . . . . . . . . . . 83

How fast is the connection with Sprint Connection Manager?  . . . . . . . . . . . . . . 83

How can I optimize my settings to achieve the fastest speeds and 
conserve data when accessing my corporate network?  . . . . . . . . . . . . . . . . . . . . . 84

Can I connect to a dial-up account like AOL or EarthLink?  . . . . . . . . . . . . . . . . . . . 84

Once I connect to the network, how do I access my corporate network 
through a VPN?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Why won’t my laptop go into hibernation mode when using my 
Sprint Mobile Broadband USB Modem? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

What is LBS?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

What is GPS? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

What is enhanced Local Search?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

How do I get the enhanced Local Search feature?  . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Where do I find the enhanced Local Search feature? . . . . . . . . . . . . . . . . . . . . . . . . 85

How do I use the enhanced Local Search feature?  . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Where can I use GPS?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

What is GPS User Plane? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

What is GPS Control Plane? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

How do I enable/disable GPS?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Will GPS work when Privacy is set to ON?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Can I use Sprint Location Services if I have enabled NDIS? . . . . . . . . . . . . . . . . . . . 87

Do I need a GPS subscription to use GPS?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Location-Based Services limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

What GPS mode options are supported? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

What is GPS Basic?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

What is GPS Premium? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

What is the difference between GPS Basic and GPS Premium? . . . . . . . . . . . . . . 89

What is a GPS application?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

What is NMEA?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

How do I configure a GPS application to use my GPS-capable device?  . . . . . . . 90

When do I need to use NMEA? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

How do I start and stop NMEA? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

How do I configure my NMEA port? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91



3F. Troubleshooting Tips (Windows) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92

Problems, Causes, and Solutions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

GO Button Is Unavailable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Searching for Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Cannot Connect to the Network  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

PWR LED Goes Off and On, and Then Stays Red . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Sprint Location Services Aren’t Working or Don’t Seem to Be Available . . . . . . 96

Could Not Prepare Data Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Unable to Prepare Data Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Sprint Connection Manager Stops Working After Upgrading Windows . . . . . . 97

Section 4: Installing and Using the USB Modem on a Mac . . . . . . . . . . . . . . . . . . . . . . .99

4A. Installing and Using the Software on a Mac Computer  . . . . . . . . . . . . . . . . 101

Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Installing the Software on a Mac  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

Installing the Drivers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

USB Modem Activation and Provisioning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107

Connecting to the Sprint Network  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110

Icons and Text in Watcher Lite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110

Menu Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Attaching an External Antenna . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

Removing Your USB Modem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Sprint Service Areas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Manage Your Account Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Troubleshooting Tips (Mac) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Frequently Asked Questions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

Section 5: Technical Specifications and Regulatory Information  . . . . . . . . . . . . . . . 117

5A. Technical Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

LED Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Radio Frequency and Electrical Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121

Software Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

Environmental Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123

Mechanical Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123



5B. Regulatory Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

Regulatory Notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .125

Patents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Trademarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Copyright . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Limitation of Liability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

Additional Information and Updates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

Section 6: Safety Information and Terms & Conditions  . . . . . . . . . . . . . . . . . . . . . . . 131

6A. Safety and Notices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Important Notice  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

Safety and Hazards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

6B. Terms and Conditions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Subscriber Agreement/General Terms and Conditions of Services  . . . . . . . . . 136

Section 7: Glossary and Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

7A. Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155

7B. Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159



     i

Welcome to Sprint

We are committed to bringing you the best wireless technology available, and we 
built our network right from the start, so no matter where you are on the network, 
all your services will work the same.

When it comes to mobile connectivity, the Sprint Mobile Broadband USB modem 
offers more freedom than ever before. No wires, no cables, just access to your data 
when you need it. The power of the Internet and company data is truly at your 
fingertips.

This guide will familiarize you with our technology and with Sprint Connection 

ManagerSM software with enhanced Local Search (for Windows computers), 
Watcher® Lite software (for Mac computers), and your new Sprint Mobile 
Broadband USB modem through simple, easy-to-follow instructions.

Welcome and thank you for choosing Sprint.
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Introduction

This User’s Guide introduces you to Sprint service and all the features of your new 
wireless Sprint Mobile Broadband USB modem. It’s divided into seven sections:

� Section 1:  Basics of Your USB Modem

� Section 2:  Installing the USB Modem on a Windows Computer

� Section 3:  Using the USB Modem on a Windows Computer

� Section 4:  Installing and Using the USB Modem on a Mac

� Section 5:  Technical Specifications and Regulatory Information

� Section 6:  Safety Information and Terms & Conditions

� Section 7:  Glossary and Index

Throughout the guide, you’ll find tips that highlight special shortcuts and timely 
reminders to help you make the most of your USB modem and services.

The Table of Contents and Index will help you locate specific information quickly. 
The Sprint Connection Manager software (for Windows) includes extensive online 
help to guide you through the steps to use each feature.

You’ll get the most out of your new Sprint Mobile Broadband USB modem if you 
read each section of this document. However, if you’d like to get right to a specific 
feature, simply go to that page. Follow the instructions in that section and you’ll 
be ready to use your USB modem in no time.

Tip: You can view this guide online or print it to keep on hand. If you’re viewing it online, 
simply click a topic in the Table of Contents, a page number in the Index, or any page 
or section reference. The PDF automatically displays the appropriate page.
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Basics of Your USB Modem
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Sec tion 1A

Introducing the Sprint Mobile Broadband 
USB Modem

In This Section

� Your Sprint Mobile Broadband USB Modem

� CDMA Networks

� One Touch Activation

� Package Contents

� Care and Maintenance

� About This Guide

This section introduces the basic features and functions of your Sprint Mobile 
Broadband USB modem, what is included with your USB modem, and how to use 
this guide to get you started.
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Your Sprint Mobile Broadband USB Modem

The Sierra Wireless AirCard® 595U USB modem is a dual-band wireless USB 
modem. It enhances the functionality of your mobile or desktop computing 
devices by adding wireless data.

This USB modem allows you to do the following (subject to feature availability), 
without using a landline network or phone:

� Easily activate your account (One Touch Activation)

� Connect to the Internet, VPNs, and corporate networks

� Send and receive large email messages

� Use Sprint Location Services (Windows® only)

� Conduct Internet-based videoconferencing

� Access streaming real-time media

� Play games online

Your Sprint Mobile Broadband USB modem fits into a USB slot (available on most 
notebook and desktop computers).

CDMA Networks

The USB modem operates over a type of wireless network called CDMA (Code 
Division Multiple Access).

To use the USB modem, you need an account that gives you access to the CDMA 
network. Some features described in this manual may not be available with your 
account. For details of the services and accounts available, contact Sprint 
(page 13).

There are CDMA networks that operate in the frequency bands supported by the 
USB modem throughout North America. However, each service provider operates 
a network that covers a limited geographical area within the overall CDMA 
coverage area.

The fee for service may be higher when you are roaming (connecting to a network 
other than Sprint).

Sprint has “roaming” agreements with other service providers, so that you can get 
service outside of the coverage area of the network. (There may be additional 
charges for roaming service.)
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CDMA technology provides a variety of connectivity features, depending on your 
Sprint account (actual speed depends on the network conditions):

� 1xEV-DO Rev. A (Sprint Power VisionSM) supports Internet connections with data 
rates up to 3.1 Mbps (downlink from the network) and 1.8 Mbps (uplink to the 
network). Average data rates are 600 kbps - 1.4 Mbps (downlink from the 
network) and 350-500 kbps (uplink to the network).

� 1xEV-DO Rev. 0 (Sprint Power Vision) supports Internet connections with data 
rates up to 2.4 Mbps (downlink from the network) and 153 kbps (uplink to the 
network). Average data rates are 400-700 kbps (downlink from the network) 
and 40-80 kbps (uplink to the network).

� 1X (Sprint Vision) supports Internet connections with data rates up to 153 kbps. 
Average data rates are 40-80 kbps.

One Touch Activation

Where supported by the network, One Touch Activation (IOTA 2.4) lets you easily 
activate your USB modem. When prompted, you simply click “Yes” to indicate that 
you’d like the network to autoprogram your USB modem. If this is successful, you 
are ready to connect to the network.

Tip: More information about CDMA networks is available on the CDMA Development 
Group Web site, www.cdg.org.

Tip: For pointers on optimizing your settings, see “How can I optimize my settings to 
achieve the fastest speeds and conserve data when accessing my corporate 
network?” on page 84.

http://www.cdg.org
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Package Contents

Your Sprint Mobile Broadband USB modem package contains the following 
components:

� Sprint Mobile Broadband USB modem by Sierra Wireless (Model AirCard 595U)

� Rechargeable modem battery

� USB extension cable

� Getting Started guide

� Installation CD containing the Sprint Connection Manager software (for 
Windows computers) and the Watcher Lite software (for Mac computers), 
warranty information, and this document

Care and Maintenance

As with any electronic device, the USB modem must be handled with care to 
ensure reliable operation. Follow these guidelines in using and storing the USB 
modem:

� The USB modem should fit easily into your USB slot. Forcing the USB modem 
into a slot may damage the connector pins.

� Protect the USB modem from liquids, dust, and excessive heat.

� When not installed in your computer, store the USB modem in a safe place.

� Remove the USB modem before storing or transporting your computer.

� When inserting or removing the USB modem, always grip it by the sides rather 
than the end, as this prevents damage to the USB modem.

� To avoid the risk of explosion, use the same battery model when replacing the 
battery. Properly dispose of the used battery.

� The USB modem’s USB connector is adjustable to three positions. Do not force 
the hinge past the last position—this may break the connector. For more 
information, see the picture on page 19.

� Do not use the USB modem with a handheld computer; it is designed only for 
notebook or desktop computers running Windows Vista, Windows XP, 
Windows 2000, or Mac OS X.
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� Do not handle or operate the USB modem while driving or operating a vehicle. 
Doing so may distract you from properly operating the vehicle. In some states 
and provinces, operating communication devices while in control of a vehicle is 
a criminal offense.

About This Guide

This user’s guide is designed to provide you with all the information you need to 
install and use your USB modem by Sierra Wireless (AirCard 595U).

� Section 1 (which you are reading) gives you an overview of the USB modem 
(AirCard 595U).

� Section 2 provides step-by-step instructions for installing the USB modem and 
Sprint Connection Manager software on a Windows computer (page 15).

� Section 3 provides step-by-step instructions on using the USB modem on a 
Windows computer (page 29).

� Section 4 provides step-by-step instructions for installing and using the USB 
modem on a Mac computer (page 99).

� Section 5 provides electrical, radio frequency, and other parameters of the USB 
modem for those who require technical information, as well as regulatory 
information (page 117).

� Section 6 provides important safety and liability information and the Terms and 
Conditions of use for the Sprint Mobile Broadband USB modem (page 131).

� Section 7 include a glossary (page 155) and index (page 159).

Note: The comprehensive Getting Started guide that comes with the 
Sprint Mobile Broadband USB modem should be sufficient for most 
installations.
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Sec tion 1B

Getting Started With Your USB Modem

In This Section

� Getting Started

� System Requirements

� The USB Modem Software

This section describes the basics of getting started with your USB modem, and 
how to look after your USB modem.
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Getting Started

Before you begin using your USB modem, you must:

1. Check that your computer has the system requirements listed below (“System 
Requirements”).

2. Install the Sprint Connection Manager software (for Windows) or the 
Watcher Lite software (for the Mac), located on the installation CD, onto your 
computer. See page 18 (Windows) or page 102 (Mac).

3. Start the software.

4. Insert the battery into the USB modem, and insert the USB modem into your 
computer; this installs the drivers for the USB modem.

5. Charge the battery for approximately two hours.

6. Activate your Sprint account and configure the USB modem to use your 
account (unless the USB modem has been preactivated). See page 24 
(Windows) or page 107 (Mac).

System Requirements

The Sprint Mobile Broadband USB modem is supported on:

� Windows Vista.

� Windows XP with Service Pack 2.

� Windows 2000 with Service Pack 4 and high encryption support. (See “High 
Encryption Requirements (Windows)” on page 10.)

� Mac OS X version 10.4 or newer. For instructions on installing and using the 
software, see “Installing and Using the Software on a Mac Computer” on 
page 101.

CAUTION: Do not insert the USB modem into the USB slot until you have 
installed and run the software, and the software displays “No device.”
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To install and run the USB modem and accompanying Sprint Connection Manager 
software on a Windows computer, you will need the minimum system resources 
shown in the following table.

High Encryption Requirements (Windows)

Depending on your configuration, an IOTA (Internet Over The Air) session may 
automatically start as part of the installation/activation process. IOTA requires 
high-security 128-bit encryption to establish a secure Internet connection to the 
CDMA network. (For more information, see “Data Provisioning [IOTA]” on 
page 27.)

If you are running Windows Vista or Windows XP, your computer should already 
include high-security 128-bit encryption.

If you are running Windows 2000 with Internet Explorer
1. Ensure you have installed the Windows 2000 High Encryption Pack: in Internet 

Explorer, select Help > About Internet Explorer.

If you see “Cipher Strength: 128-bit,” then the High Encryption Pack is 
installed. Proceed to step 2.

If the High Encryption Pack is not installed, download and install it 
(www.microsoft.com/windows2000/downloads/recommended/encryption).

2. If your version of Internet Explorer is earlier than 5.5, download and install the 
latest version (www.microsoft.com/windows/ie/downloads).

USB slots One USB slot. (If your computer’s USB slot is vertical, use the 
USB extension cable. Do not use the USB modem or USB 
extension cable in a USB hub or in a USB slot on a keyboard.)

Optical drive CD-ROM

Memory 32 MB

Disk space 32 MB

www.microsoft.com/windows/ie/downloads
www.microsoft.com/windows2000/downloads/recommended/encryption
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If you are running Windows 2000 with Netscape Communicator

Ensure your version of Netscape Communicator is 4.7 or higher.

To verify that your version supports 128-bit encryption:

1. In Navigator, select Help > About Navigator. 

– or –

In Netscape Communicator, select Help > About Communicator.

2. See the section “Contains encryption software from RSA Data Security, Inc.” 

If the next paragraph states “This version supports U.S. security,” you have 
128-bit security.

If the paragraph states that you have International security, you have 40-bit 
security. Download a version that supports 128-bit security.

The USB Modem Software

The Sprint Mobile Broadband USB modem comes with the following software:

� Sprint Connection Manager, which allows you to manage the USB modem’s 
actions and monitor your connections on a Windows computer

� Watcher Lite, which allows you to manage the USB modem’s actions and 
monitor your connections on a Mac computer

� The driver software that forms the interface between the USB modem and your 
Windows or Mac operating system

Before you insert the USB modem for the first time, you must install and then run 
the Sprint Connection Manager (Windows) or Watcher Lite (Mac) software. The 
driver software is installed the first time you insert the USB modem into your 
computer.

Detailed instructions are provided beginning on page 18 (for Windows) and 
page 102 (for Mac).
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Sec tion 1C

Getting Help

In This Section

� Visiting the Sprint Web Site

� Contacting Sprint Customer Service

� Troubleshooting

This section describes where you can find more information on Sprint services, 
options, and troubleshooting problems you have encountered.
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Visiting the Sprint Web Site

Stop by www.sprint.com and log on to get up-to-date information on Sprint 
services, options, and more.

You can also:

� Review coverage maps.

� Access your account information.

� Add additional options to your service plan.

� Purchase accessories.

� Check out frequently asked questions.

� And more.

Contacting Sprint Customer Service

You can reach Sprint Customer Service by:

� Logging on to your account at www.sprint.com.

� Calling us toll-free at 1-888-788-4727 (business use) or 1-888-715-4588 (personal 
use).

� Writing to us at Sprint Customer Service, P.O. Box 8077, 
London, KY  40742.

Troubleshooting

The Online Help for Sprint Connection Manager on your Windows computer (see 
page 54) includes descriptions of most common error messages. Look in the 
Contents under Troubleshooting.

For help with other problems:

� See “Troubleshooting Tips (Windows)” on page 92 or “Troubleshooting Tips 
(Mac)” on page 113.

� Consult the Sierra Wireless Web site at www.sierrawireless.com, where you will 
find an extensive knowledge base that can be searched to address most 
problems, and the Installation Troubleshooting wizard (in the Support & 
Download section).

� Contact Sprint as noted above.

http://www.sprint.com
http://www.sprint.com
http://www.sierrawireless.com
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Sec tion 2A

Installing the Software on a Windows Computer

In This Section

Getting Started

This section explains how to install your Sprint Connection Manager software on 
a Windows computer.

The process may vary, depending on the version of Windows that you are running.

(If you’re using your USB modem on a Mac computer, see “Installing and Using the 
Software on a Mac Computer” on page 101.)



18 Section 2A: Installing the Software on a Windows Computer

Getting Started

Before you can use your USB modem, you must first install the USB modem’s 
software and configure the USB modem for your computer. The installation 
process consists of:

� Software installation - Installing the Sprint Connection Manager software on 
your computer (described in this section).

� Insertion of the rechargeable battery into the USB modem

� USB modem insertion and driver installation - Starting the Sprint Connection 
Manager software and inserting the USB modem, which automatically installs 
the drivers on your computer.

� USB modem activation and provisioning - Activating your Sprint account and 
configuring the USB modem to use your account. (See “Setting Up Service 
[Windows]” on page 23.)

To install the software on your computer:

1. If the installation CD is not already in your CD-ROM drive, insert it.

The CD should autostart.

If the CD does not autostart, select Start > Run and enter d:\SCMInstaller.exe, 
where d is the drive letter of your CD-ROM drive.

2. Use the Next and Back buttons to navigate through the wizard, noting the 
following:

� You must select I accept the terms in the license agreement to indicate your 
acceptance of the terms of the license agreement to proceed with the 
installation.

Note: For comprehensive instructions on installing the Sprint Connection 
Manager software and activating the USB modem, see the Getting Started 
guide.

CAUTION: Do not insert the USB modem into your computer’s USB slot before 
installing the software.

Note: Windows Vista and Windows 2000 users: You must log in with 
administrative privileges to install the software and drivers.
Windows XP users: You may need to log in with administrative privileges, 
depending on your Windows configuration.

Before beginning the installation process, it is recommended that you close 
all open applications.
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� Use the default settings for the Destination Folder unless you have special 
requirements and an advanced understanding of computer configuration. 
(The Destination Folder dictates where the software is installed.)

3. When the “Installation Complete!” window is displayed, click Finish.

4. Run Sprint Connection Manager.

(Double-click the program’s icon [ ] on your desktop.)

5. Wait for Sprint Connection Manager to start up and display “No device...”.

6. Slide the front panel off the USB modem.

7. Hold the battery so that the side with two white arrows faces up and the gold 
contact points on the end of the battery line up with the gold contact points 
on the USB modem. Insert the battery into the USB modem.

8. Slide the front panel onto the USB modem until the panel clicks into place.

9. Slide the lever on the bottom of the USB modem in the direction indicated by 
the triangle to release the USB modem's USB connector.

10. Adjust the USB connector to the desired angle. (The USB connector is 
adjustable to three positions—approximately 90, 135, and 160 degrees. Do 
not force the hinge past the last position—this may break the connector.)

11. Gripping both sides of the USB modem, insert it into your computer’s USB slot.

Alternatively, you can attach the USB extension cable to your computer’s USB 
slot, and then connect the USB modem to the USB extension cable.

Warning: To avoid the risk of explosion, use the same battery model when replacing 
the battery. Properly dispose of the used battery.

Note: If your computer’s USB slot is vertical, use the USB extension cable. 
Do not insert the USB modem or USB extension cable into a USB hub or a 
USB slot on a keyboard.
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Windows detects the USB modem and installs the drivers for it. This may take a 
few minutes. Once completed, Sprint Connection Manager should display 
“Disconnected” (if your USB modem is preactivated) or the “One Touch Activation” 
window, or automatically start the Activation Wizard.

The PWR LED is lit.

12. Allow the battery to charge for approximately two hours before closing the 
window or making a selection in it.

13. If your USB modem is preactivated or if you have activated it at the time of 
purchase, proceed to “Preactivated USB Modem” on page 24.

14. Proceed to “Non-preactivated USB Modem: One Touch Activation” on page 25 
if your USB modem has not been activated.

Warning: If the orientation of your computer’s USB slot or the thickness of your 
computer are such that pressure is applied to the USB modem’s end or side 
(as shown by the red circles in the drawings below), you may damage the 
USB modem or your computer. In such cases, do not insert the USB modem 
directly into your computer’s USB slot; use the USB extension cable instead.

Note: If you have an older version of Sprint Connection Manager and are 
experiencing problems during installation, use the Add/Remove Programs 
Utility (see page 59) to remove the older version of Sprint Connection 
Manager. Then reinstall the current version of Sprint Connection Manager 
from the Installation CD.
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Section 2B

Inserting and Removing the USB Modem

In This Section

� Inserting the USB Modem

� Removing the USB Modem

This section describes how to properly insert the USB modem and remove it from 
your computer.
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Inserting the USB Modem

To insert the USB modem into a notebook or desktop computer:

� Holding the USB modem by its sides, insert it into the USB slot of your 
computer.

Alternatively, you can attach the USB extension cable to your computer’s USB 
slot, and then connect the USB modem to the USB extension cable.

When you insert the USB modem into a Windows computer, the following should 
occur:

� The first time the USB modem is inserted, Windows detects the USB modem 
and installs the drivers for it. This may take a few minutes. Once completed, 
Sprint Connection Manager should display “Disconnected.” To connect to the 
network, click GO in the Mobile Broadband window.

� If sound effects are enabled, the computer beeps.

The USB modem is powered as soon as you insert it.

Removing the USB Modem

To remove the USB modem:

1. Exit Sprint Connection Manager if it is open (page 49).

2. Remove the USB modem from your computer’s USB slot by gripping both 
sides of the USB modem and pulling straight out.

Note: If your computer’s USB slot is vertical, use the USB extension cable. Do not 
insert the USB modem or USB extension cable into a USB hub or a USB slot 
on a keyboard.

IMPORTANT! When inserting or removing your USB modem, always grip the USB 
modem by its sides, as this prevents damage to the USB modem.
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Sec tion 2C

Setting Up Service (Windows)

In This Section

� Activating and Using Sprint Service

� Preactivated USB Modem

� Non-preactivated USB Modem: One Touch Activation

� Non-preactivated USB Modem: Activation Wizard

� Data Provisioning (IOTA)

This section walks you through setting up service for your Sprint Mobile 
Broadband USB modem after you have installed the Sprint Connection Manager 
software (page 18) and inserted the USB modem.
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Activating and Using Sprint Service

Before using your USB modem, you must have a Sprint wireless network account 
set up. The process of setting up an account is called activation.

When the USB modem is inserted and Sprint Connection Manager is started, it 
will detect whether the USB modem has been configured with an account 
(“preactivated”). If it has not, the “One Touch Activation” window or the 
Activation Wizard starts automatically.

Preactivated USB Modem

If you received your USB modem in the mail or purchased it at a Sprint Store, it 
probably has already been activated.

To prevent unauthorized use, preactivated USB modems may have been set with a 
security lock. If so, Sprint Connection Manager displays the message “Device 
locked.”

To unlock your USB modem:

1. Click the  icon. (If is not visible, in the Mobile Broadband window click  to 
expand Sprint Connection Manager.)

2. In the Enter User Lock Code window, enter your four-digit lock code, and click 
OK. For security purposes, the code is not visible as you type.

After unlocking your preactivated USB modem, it is ready for use. See “Using the 
USB Modem on a Windows Computer” on page 29.

Tip: If you can’t recall your lock code, try using the last four digits of your USB 
modem’s phone number (MDN). If this doesn’t work, call Sprint Customer 
Service at 1-888-788-4727 (business use) or 1-888-715-4588 (personal use).
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Non-preactivated USB Modem: One Touch Activation

If the “One Touch Activation” window has been displayed, click Yes to indicate that 
you’d like to have the network autoprogram your USB modem.

Sprint Connection Manager will display “Updating User Profile.”

If One Touch Activation is successful, Sprint Connection Manager will then display 
“Disconnected,” after which you are ready to connect to the network (click GO). To 
learn about using the software, see “Using the USB Modem on a Windows 
Computer” on page 29.

If One Touch Activation was not successful, a message window is displayed. To 
activate your USB modem, use the Activation Wizard (see the next section).

Non-preactivated USB Modem: Activation Wizard

If your USB modem is not preactivated, please see the Getting Started guide 
included with your USB modem.

The Activation Wizard will guide you through the activation process.

To set up your account, you will be contacting Sprint.

Before you call Sprint, have these things ready:
� A phone

� Your USB modem

� The city and state where the USB modem will be primarily used

� A pen and paper to write down your account information. Your package 
includes a printed Getting Started guide, where you can record this 
information.

Note: If you successfully activated your USB modem through the “One Touch 
Activation” window (page 25), skip these steps and go directly to “Using the 
USB Modem on a Windows Computer” on page 29.
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When you call Sprint, Sprint Customer Service will help you select your service 
plan and guide you through the activation process. They will also provide you with 
this information:

� Your USB modem’s activation code (gives you access to configure the account)

� Your USB modem’s phone number (MDN)

� Your USB modem’s MSID (Mobile System ID) code, used for WLNP (Wireless 
Local Number Portability) and to determine whether you are “home” or 
“roaming”

Stepping Through the Activation Wizard
If the Activation Wizard has not started automatically:

1. Ensure the USB modem is inserted, and Sprint Connection Manager is 
running. If Sprint Connection Manager is not running, select:
(Windows Vista or Windows XP) Start > All Programs > Sprint > Sprint Mobile 
Broadband (Sierra).
(Windows 2000) Start > Programs > Sprint > Sprint Mobile Broadband (Sierra).

Sprint Connection Manager should display “Disconnected.”

2. If Sprint Connection Manager displays “Device locked,” unlock the USB 
modem (page 57).

3. If Sprint Connection Manager displays “Device powered off,” power the USB 
modem on (page 40).

4. Start the Activation Wizard: select MENU > Settings > Sprint Mobile Broadband - 
Sierra Wireless > Activation Wizard.

Once the Activation Wizard is running:

1. To begin activation of the USB modem, click Next.

2. Call Sprint at the appropriate phone number listed on the screen. Click Next.

3. Give the account representative your ESN (Electronic Serial Number) or MEID 
(Mobile Equipment IDentifier) number as displayed by the Activation Wizard. 
Enter the activation code provided by the account representative and 
click Next.

4. Enter the phone number (no spaces or hyphens) and, if not the same value as 
the phone number, the MSID value given by the account representative, and 
then click Next.

A confirmation window will be displayed.

5. Confirm with the service representative that the information is correct. If it is, 
click Yes. If it isn't, click No, and re-enter the information.
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6. Click Finish to close the Activation Wizard.

7. Wait a few moments for the USB modem to automatically reset. Depending 
on your configuration, an IOTA session may automatically start. (See “Data 
Provisioning [IOTA]” on page 27.)

After Sprint sets up your account on the network, your USB modem should be 
configured and ready for use. To learn about using the software, see “Using the 
USB Modem on a Windows Computer” on page 29.

Data Provisioning (IOTA)

IOTA (Internet Over The Air), supported by some service providers (including 
Sprint), is an automated feature to perform account setup for you by making a 
connection to the CDMA network and using a secure Internet connection to 
download account parameters to your USB modem. To make this secure 
connection, IOTA requires that your computer support 128-bit encryption. (See 
“High Encryption Requirements (Windows)” on page 10.)

Depending on your configuration, the first time Sprint Connection Manager 
detects the activated USB modem, an IOTA session may automatically start, 
during which status messages (“Updating User Profile…”) are displayed.

After this first activation, there may be changes to your account that require 
updating the parameters in the USB modem. If this is needed:

1. In the Device Info & Diagnostics window (page 77), click Update Data Profile. 
(If this button is not displayed, remove and reinsert the USB modem.)

2. In the IOTA Provisioning window, click Yes.

Your USB modem then retrieves the updates to your data services account. Once 
the updates are successful, Sprint Connection Manager is displayed 
(“Disconnected”). You can now connect to the network.
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Sec tion 3A

Your USB Modem: The Basics

In This Section

� Sprint Connection Manager

� Starting Sprint Connection Manager

� Starting Sprint Connection Manager Automatically

� Sprint Connection Manager Window

� Connection States (Mobile Broadband Window)

� GPS Status (GPS Receiver Window)

� System Tray Connection States

� Determining the Type of Coverage

� Attaching an External Antenna

� Sprint Location Services

� Powering the USB Modem On and Off

� Controlling the Sprint Connection Manager Window

� Launching a Sprint Power Vision or Sprint Vision Connection

� Viewing the Amount of Data Transferred

� Ending a Connection

� Online Help

� Displaying Your Phone Number

� Security

� Accessing Links

� Uninstalling the Sprint Connection Manager Software
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Sprint Connection Manager

Sprint Connection Manager is the application that allows you to manage and 
monitor, on your Windows computer, the high-speed Sprint Power Vision 
(1xEV-DO) and Sprint Vision (1X) connection to the Sprint network. You use 
Sprint Connection Manager to:

� Determine your signal strength and other network connection parameters (page 33).

� Initiate data calls (page 50).

� Access Sprint Location Services (page 43).

� View call statistics (page 75) and messages (page 38).

� Customize features and options (page 65).

Starting Sprint Connection Manager

To start Sprint Connection Manager:

1. Ensure the USB modem is inserted into your computer’s USB slot.

2. Double-click the program’s icon ( ) on your desktop, or, from the Start menu 
on your Windows desktop, select:
(Windows Vista or Windows XP) All Programs > Sprint > Sprint Mobile Broadband 
(Sierra).
(Windows 2000) Programs > Sprint > Sprint Mobile Broadband (Sierra).

When Sprint Connection Manager is running, it places an icon ( ) in the system 
tray, usually at the right end of the taskbar. If Sprint Location Services are 

supported and enabled, then a second icon ( ) is displayed in the system tray. 
(See page 42.)

Tip: Without running Sprint Connection Manager, you can make a data connection 
simply by starting whatever application you want to use (such as your Web browser 
or email application). Prerequisites: you must have previously selected, in 
Sprint Connection Manager, Enable Network Adapter (NDIS) (page 69). However, to 
make use of other features of the USB modem (including Sprint Location Services), 
you must run Sprint Connection Manager.

Tip: You can also set Sprint Connection Manager to launch automatically 
whenever Windows starts. (See “Starting Sprint Connection Manager 
Automatically” on page 33.)
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Starting Sprint Connection Manager Automatically

To set Sprint Connection Manager to start automatically whenever Windows starts:

� From the General option in the Settings window (page 66), select Launch when 
Windows starts.

Sprint Connection Manager Window

If Sprint Location Services and the GPS Receiver window are not supported or not 
enabled (page 72), then only the Mobile Broadband window is displayed:

If Sprint Location Services and the GPS Receiver window are supported and 
enabled, then the GPS Receiver window is additionally shown below the Mobile 
Broadband window:

Note: Changes to this setting apply only after you restart Windows.

Tip: You can also set the connection to launch automatically whenever available. 
(See “GO automatically when ready” on page 69.) These settings provide an 
“always-on” connection, as long as you have network coverage.
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Mobile Broadband Window

The text and icons in the Mobile Broadband window indicate the connection state 

(page 38), and, when disconnected, whether the USB modem is locked  or 

unlocked  (page 55).

The Mobile Broadband window may display, depending on the connection state, 
some of the following icons:

CDMA network signal strength, indicated by the number of bars.

The ToolTip indicates the type of coverage you have (for example, 1X 
and/or 1xEV-DO), and the signal strength, in dBm.

You are roaming. Roaming charges may apply.

Note: Sprint Location Services may not be available when roaming.

If this icon is flashing, you are in a non-preferred roaming area, and you 
may not be able to complete your calls.

Tip: You can change the roaming option (“Roam Mode;” for example, to 
disable roaming, select Sprint), and also enable the Roam Guard feature (from 
the Sprint Mobile Broadband Settings window; page 68).

1xEV-DO Rev. A transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

Exit

Establish/Show/

Menu

hide
details cancel a

MinimizeMessage area Indicator area

connection
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GPS Receiver Window

1xEV-DO Rev. 0 transmit/receive icon: a data connection is active.

The up arrow is animated (for example: ) when data is being 
transmitted to the network.

The down arrow is animated (for example: ) when data is being 
received from the network.

1xEV-DO (Rev. 0 and Rev. A) transmit/receive icon: the data connection 
is dormant. The up and down arrows are gray.

1X transmit/receive icon: a data connection is active.

The up arrow is black and animated when data is being transmitted to 
the network.

The down arrow is black and animated when data is being received 
from the network.

1X transmit/receive icon: the data connection is dormant. The up and 
down arrows are gray.

Exit

Start/end
Show/

Menu

hide
details NMEA output

MinimizeMessage area Indicator area

Location
information
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The text and icons in the GPS Receiver window indicate the following (described in 
the table that follows):

� GPS status

� GPS/Privacy status

� Satellite status

� Location information (when the GPS Receiver window is expanded)

The GPS Receiver window may display, depending on the GPS/Privacy status and 
satellite status, some of the following icons and text. The icons’ ToolTips in 
Sprint Connection Manager provide more information.

Privacy is on (you have not accepted the Privacy Consent Agreement). 
Sprint Location Services are not available.

To use Sprint Location Services, in the Sprint Location Services settings 
window, select Enable Location Services.

Privacy is off. GPS is available. For the status of GPS, see the satellite 
status icon (described below).

GPS is available, but off. The satellite and the vertical bars are not 
colored.

To use GPS, click GO in the GPS Receiver window.

GPS is on, but not usable (searching for satellites). The vertical bars are 
not colored.

The ToolTip indicates the number of satellites.

GPS is on and is usable, but with lower accuracy. The vertical bars are 
colored.

The ToolTip indicates the number of satellites acquired.

GPS is on and is usable, with better accuracy. The vertical bars are 
colored.

The ToolTip indicates the number of satellites acquired.

Latitude Latitude, in decimal degrees. For example, -17.123°

Longitude Longitude, in decimal degrees. For example, 23.023°

HEPE Accuracy (horizontal/vertical precision), in feet.

Speed Current speed, in miles per hour.
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Common items

Sprint Connection Manager may display, depending on the settings of your USB 
modem, the following buttons and text:

� Menu or the  button — Displays the Sprint Connection Manager menu 
(page 61).

�  (upper right corner of the window) — Minimizes Sprint Connection Manager 
(page 49).

�  — Exits Sprint Connection Manager (page 49).

�  (Mobile Broadband window) — Expands the Mobile Broadband window 
(page 46) and displays the amount of data transferred (when Connected), or, 

when disconnected, the lock status of your USB modem (locked  or unlocked 

).

�  (Displayed when the Mobile Broadband window is expanded) — Hides the 
amount of data transferred and the lock status of your USB modem (page 46).

� GO (Mobile Broadband window) — Starts the Sprint Power Vision or 
Sprint Vision connection (page 50).

� Stop (Mobile Broadband window) — Ends the data connection (visible when a 
connection is established; page 54); also ends the NMEA output.

�  (GPS Receiver window) — Expands the GPS Receiver window (page 46) and 
displays location information.

�  (Displayed when the GPS Receiver window is expanded) — Hides the 
location information.

Satellites Number of satellites used in the current GPS fix.

Altitude Altitude, in feet.

Last fix Date/time that the GPS values were last acquired.

GPS Port The current NMEA port. (For information on NMEA, see “What is 
NMEA?” on page 90.)

This information is useful when configuring a GPS application to use 
your GPS-capable device (page 90).

Heading Current direction, in degrees.
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� GO (GPS Receiver window) — Starts the NMEA output (page 91).

� Stop (GPS Receiver window) — Ends the NMEA output.

Connection States (Mobile Broadband Window)

The Mobile Broadband window can display various connection and interaction 
states, including:

� No device

� Initializing

� Updating User Profile… (See “Data Provisioning [IOTA]” on page 27.)

� Searching for service...

� Disconnected

� Connecting

� Connected

� Connected to NDIS

� Device locked

� Device powered off

No device

Sprint Connection Manager did not detect the USB modem. The GO button is 
unavailable.

Insert the USB modem. If it is already inserted, remove and reinsert it; wait a few 
moments. If this message is still displayed, uninstall (page 59) and reinstall 
Sprint Connection Manager, or contact Sprint (page 13).

Note: The system tray icon also indicates the connection state (page 31).
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Initializing

Sprint Connection Manager is attempting to establish communication with the 
USB modem.

Searching for service...

Sprint Connection Manager is determining whether 1X or 1xEV-DO service is 
available. If this message persists, see page 94.

Disconnected

Sprint Connection Manager is ready to make a connection to the network or to use 

Sprint Location Services. The GO button is available; the signal strength icon ( ) 

and the roaming icon ( ) (if you’re roaming) are visible. If the Mobile Broadband 

window is expanded, the lock icon (  or ) is visible.

To connect to the network, click GO.

Connecting

Sprint Connection Manager is establishing a connection to the network.

Connected

The connection is established. In addition to the signal strength icon ( ) and the 

roaming icon ( ) (if you’re roaming), the transmit/receive icon (  for 1xEV-DO 

Rev. A;  for 1xEV-DO Rev. 0;  for 1X) is also displayed.

If you expand the Mobile Broadband window ( ), the amount of data transferred 
is shown. (See note on page 53.)
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To end the connection, click Stop.

Connected to NDIS

This message applies only if Enable Network Adapter (NDIS) (page 69) has been 
selected. For a description, see “Connected” (above).

Device locked

The USB modem is locked, so that others cannot use the USB modem and your 
account. To use most of the features, you must unlock the USB modem (page 57).

Device powered off

The USB modem has been powered off (through Menu > Power Off Modem). To use 
the USB modem, select Menu > Power On Modem.

For more information, see “Powering the USB Modem On and Off” on page 45.
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GPS Status (GPS Receiver Window)

The GPS Receiver window displays the GPS status:

� OFF

� Validating

� Searching

� Acquired

OFF

GPS is not available or is turned off.

To use GPS:

1. Ensure the USB modem is not powered off and the GPS Receiver window is  
displayed.

� If the GPS Receiver window is not displayed, in Sprint Connection Manager 
select MENU > Settings > Sprint Location Services, and then select Enable Location 
Services and Display GPS Receiver. (If Privacy Consent Agreements are displayed, 
you must read and accept them.)

2. Click GO in the GPS Receiver window.

If the GPS Receiver window still displays “OFF,” ensure Network Mode (page 69) is 
set to Automatic or 1X Only, and (subject to change) ensure that you are in the 
network coverage area (not roaming).

Validating

The network is authenticating your wireless or GPS subscription.

Searching

Sprint Connection Manager is searching for satellites.

Acquired

Satellites have been acquired and location coordinates are available for use (and 
displayed in the GPS Receiver window [page 36]).

Tip: You can turn off the display of the Privacy Consent Agreements (from the Sprint 
Location Services settings window; page 71).
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NMEA output is being generated. (For information on NMEA, see “What is 
NMEA?” on page 90.)

System Tray Connection States

Sprint Connection Manager has an associated icon ( ) that appears in the 
system tray. The icon reflects the connection state.

Clicking the system tray icon toggles between displaying and minimizing 
Sprint Connection Manager.

Right-clicking the icon displays the shortcut menu (page 63).

If Sprint Location Services are supported and enabled, then a second icon ( ) is 
displayed in the system tray. The ToolTip indicates GPS and satellite status.

Sprint Connection Manager is not ready to connect to the network. 
Your USB modem is either locked (“Device locked”; page 40), not 
detected (“No device”; page 38), or powered off (“Device powered 
off”; page 40).

Disconnected — Sprint Connection Manager is ready to make a 
connection to the network (page 39), or
Connecting — Sprint Connection Manager is making a connection 
to the network (page 39).

Connected — Connection is established to the network; data 
transfer is in progress (page 39).

Dormant — Connection is established, but no data transfer is 
taking place.
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Determining the Type of Coverage

The ToolTip over the signal strength indicator ( ) indicates the type of coverage 
you have (for example, 1X [synonym of 1xRTT] or 1xEV-DO):

Attaching an External Antenna

You can improve the signal strength by attaching an external antenna (sold 
separately).

To attach an external antenna:

1. Remove the USB modem from your computer (page 22).

2. Flip open the rubber tab on the side of the USB modem.

3. Hold the antenna cable by the connector (end) part, and carefully insert the 
connector part of the cable into the corresponding connector on the USB 
modem.

4. Reinsert the USB modem into your computer (page 22).

Sprint Location Services

Sprint Location Services (Location & Search Services) allow you to query the 
network for information on points of interest that are near your current location. 
The network automatically determines your current location. All you have to do is 
specify the type of business that you are looking for (for example, a restaurant or 
hotel).

For limitations related to Sprint Location Services, see “Location-Based Services 
limitations” on page 88.

Tip: The type of coverage is also displayed in the lower left part of the Device Info 
& Diagnostics window under “Network Service” (page 78).
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To use Sprint Location Services:

1. Ensure that, in the settings for Sprint Location Services (page 71), you have 
selected Enable Location Services and, if you will be using GPS applications, 
Display GPS Receiver, and you have accepted the Privacy Consent Agreement(s).

2. In Sprint Connection Manager, click Menu > Location & Search Services.

If the GPS fix is successful or if data from a recent GPS fix is available, then the 
Sprint Nextel Location & Search window is displayed. The bottom part of the 
window displays location information (latitude and longitude) of your USB 
modem, and the time that the location information was acquired.

Note: If the menus and windows (page 43 and page 71) related to Sprint Location 
Services are unavailable in Sprint Connection Manager, see “Sprint Location 
Services Aren’t Working or Don’t Seem to Be Available” on page 96.
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3. From the Location & Search window, enter or select the type of item you want 
to find. If you’ve previously entered search items, a drop-down list displays the 
last five items you’ve entered. Click Go.

If more than a preconfigured period of time has elapsed since the last time you’ve 
submitted a location search, a window is displayed asking whether you want to 
get an updated (GPS) position fix. (Depending on your account, you may be 
charged for each position fix or after you have performed a certain number of 
fixes.) If your current location is different from where you submitted your last 
location search, click Yes.

Your Web browser opens and displays the results of your search query. In the 
search results of some mapping and search services, you can right-click your 
location to get additional information—for example, driving instructions.

From the Location & Search window, you can submit additional searches.

From the Settings window, you can specify the settings for Sprint Location 
Services (page 71).

Powering the USB Modem On and Off

If you are using your USB modem in an aircraft, hospital, or other environment 
where the USB modem may cause interference, you can power the USB modem 
off (without removing it from your USB slot), and still use other functions of your 
computer.

This also allows you to conserve your notebook computer’s battery and charge the 
USB modem’s battery.

To power the USB modem off:

1. Close any active data connection (page 54).

2. Select MENU > Power Off Modem.

Note: Sprint Connection Manager uses your computer’s default Web browser to 
display the results of Sprint Location Services.
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When the USB modem is powered off, the menu option switches to Power On 
Modem, the Mobile Broadband window displays the message “Device powered 
off,” and the GPS Receiver window displays “OFF.”

To power the USB modem on:

� Select MENU > Power On Modem.

Controlling the Sprint Connection Manager Window

Expanding Sprint Connection Manager

The Mobile Broadband window and, if supported and enabled (page 72), the GPS 
Receiver window each have two views: compact and expanded.

To expand Sprint Connection Manager, click  in the appropriate window.

To change back to the compact view, click .
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Mobile Broadband Window

Compact view:

Expanded view:

When expanded, the Mobile Broadband window also displays the amount of data 
transferred during the current connection, and (only when disconnected) the lock 

state of the USB modem (locked  or unlocked ).
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GPS Receiver Window

Compact view:

Expanded view:

When expanded, the GPS Receiver window displays location information 
(described in the table on page 36.)
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Minimizing Sprint Connection Manager
To save space on your screen for other programs, you can minimize Sprint Connection 
Manager:

� Click  (in the upper right corner of Sprint Connection Manager).

– or –

Click the Sprint Connection Manager icon  in the system tray.

– or –

Right-click the system tray icon and select Close Sprint Mobile Broadband.

You can use the system tray icon to monitor the connection state (page 42).

Restoring Sprint Connection Manager
To restore Sprint Connection Manager when it is minimized:

� Click the Sprint Connection Manager icon  in the system tray. 

– or –

Right-click the system tray icon and select Open Sprint Mobile Broadband.

Exiting Sprint Connection Manager
To exit Sprint Connection Manager:

� In Sprint Connection Manager, select Menu > Exit, or click the  button,

– or –

Right-click the Sprint Connection Manager icon  in the system tray and 
select Exit from the shortcut menu.

If Enable Network Adapter (NDIS) (page 69) has not been selected and a connection 
is in progress, a window is displayed asking whether you want to disconnect the 
call. To end the connection and close Sprint Connection Manager, you must click 
Yes.

Tip: You can set Sprint Connection Manager to start minimized. (See “Start in 
system tray” on page 67.)

Tip: You can prevent Sprint Connection Manager from being covered up by 
other windows by setting Always on top (page 67).



50 Section 3A: Your USB Modem: The Basics

Sprint Connection Manager closes, and the Sprint Connection Manager icons 
disappear from the system tray.

Launching a Sprint Power Vision or Sprint Vision 
Connection

To launch a connection:

� Click GO in the Mobile Broadband window. (If GO is unavailable, see “GO 
Button Is Unavailable” on page 94.)

When the connection is successfully established, the network welcome screen 
appears (unless you have turned off the welcome screen display; see “Always show 
Welcome Screens” on page 69).

The Mobile Broadband window displays “Connected” or “Connected to NDIS” 
(page 39).

You can now use your Web browser, perform data transfers, and so on.

Note: If Enable Network Adapter (NDIS) (page 69) has been selected, after exiting 
Sprint Connection Manager you are still connected to the network (data 
may still be transferred). To manage the connection, use the Windows 
network connection icon in the system tray.

Note: A connection is automatically established if you select Menu > 
Location & Search Services or click GO in the GPS Receiver window.
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The connection is “active” when data transmission is occurring. If data 
transmission stops for a period of time (determined by the network), the 
connection becomes “dormant.” When you resume data traffic, the connection 
becomes active.

To monitor the status of the connection, you can use the text (page 38) and icons 
(page 33) in the Mobile Broadband window, and the icon in the system tray 
(page 42). You can also view the amount of data transferred (page 53).

Roam Guard

The Roam Guard feature, when enabled, displays a warning message if you are 
roaming and a data connection is established or about to be established. The 
message reminds you that roaming rates may apply.

From warning message window, you can:

Tip: You can optionally specify which application to automatically launch when 
the connection is established. (See “Auto-launch upon Network 
Connection” on page 52.)
You can also set the connection to launch automatically whenever 
available. (See “GO automatically when ready” on page 69.) If the 
connection is lost, it is restarted automatically. If you also set Sprint 
Connection Manager to launch automatically (see “Launch when Windows 
starts” on page 67), this can provide an “always-on” connection, as long as 
you have network coverage.
You can have a connection established automatically—without running 
Sprint Connection Manager—simply by starting whatever application you 
want to use (such as your Web browser or email application). Select Enable 
Network Adapter (NDIS) (page 69). However, Sprint Connection Manager 
and its icon in the system tray won’t be available for you to monitor the 
status of the connection. Sprint Location Services also won’t be available.
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� Turn off the warning message for this data session only (“Do not ask again 
during this data session.”).

� Continue with the data connection (“Roam”), in which case you may be subject 
to roaming rates.

� End the data connection (“Cancel”).

To turn on the Roam Guard feature:

1. From the Sprint Mobile Broadband option in the Settings window, ensure 
Roam Mode is set to Automatic.

2. From the Roam Guard drop-down list, select Always Ask.

To permanently turn off the Roam Guard feature:

� From the Roam Guard drop-down list, select Never Ask.

Auto-launch upon Network Connection

You can optionally specify which application to automatically launch when a 
Sprint Power Vision or Sprint Vision connection is established.

To specify which application to automatically launch:

1. Ensure Sprint Connection Manager is running and not locked (page 56).

2. Ensure that your USB modem is not powered off (page 40).

3. Select MENU > Settings > Sprint Mobile Broadband - Sierra Wireless.

4. Select Auto Launch.

5. In the Auto-Launch Options window, select one of the following:

� None — Do not auto-launch any application.

� Website — Auto-launch Internet Explorer. In the URL field, specify the Web 
site (such as http://www.sierrawireless.com) you want to view on 
connection.

� Microsoft VPN (PPTP) Connection — Auto-launch a Windows VPN connection. 
Type in the address of the VPN connection, or select the VPN connection  
from the drop-down list.

� Application (VPN client, etc.) — Auto-launch an installed VPN program, or 
any other program. Enter the program path in the field, or use the Browse 
button to locate the program.

Note: This feature is available only if Roam Mode is set to Automatic (from the 
Sprint Mobile Broadband option in the Settings window; page 68).
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The changes are applied the next time you launch a connection.

Viewing the Amount of Data Transferred

To view the number of bytes sent and received during the current connection:

� If the Mobile Broadband window is not expanded, click the  button.

The number of bytes sent and received during the current connection is displayed 
to three significant digits (for example, 581 kb, 1.23 Mb, or 1.81 Mb).

Once you end the connection, all numbers reset to zero.

To hide this information,  click the  button in the Mobile Broadband window.

Note: This feature functions only when Sprint Connection Manager is running.

Note: Even though the number of bytes sent and received is displayed while the 
connection is running, this is not necessarily the actual amount of data 
being transmitted across the network. Do not use this information to estimate 
billing.
If Enable Network Adapter (NDIS) (page 69) has been selected, after exiting 
Sprint Connection Manager you are still connected to the network. Data 
may still be transferred.
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Ending a Connection

To end a connection:

� In the Mobile Broadband window, click Stop.

This ends your data connection, and also your GPS connection, if it is open.

If Enable Network Adapter (NDIS) (page 69) has not been selected and you exit 
Sprint Connection Manager while a connection is in progress, a window opens 
asking whether you want to disconnect the call. Click Yes to end the connection 
and exit Sprint Connection Manager. (See “Exiting Sprint Connection Manager” 
on page 49.)

If Enable Network Adapter (NDIS) has been selected, manually disconnecting will 
leave the USB modem disconnected. It will not reconnect until you remove and 
reinsert the USB modem.

If GO automatically when ready (page 69) has been selected, manually 
disconnecting will leave the USB modem disconnected. It will not reconnect until 
one of the following occurs:

� You make a connection through Sprint Connection Manager

� A GPS fix is successfully acquired after you initiate Sprint Location Services 
(page 43)

� You restart Sprint Connection Manager

Online Help

Sprint Connection Manager includes extensive online help to provide operating 
hints and step-by-step instructions for getting the most from your USB modem.

With Sprint Connection Manager running, you can access online help in several 
ways:

� Press <F1> when Sprint Connection Manager is the active window.

� From the Sprint Connection Manager window, select MENU > Help.

� Right-click the system tray icon ( ) and select Help.

The help file has a table of contents and an index.

Note: The Stop button in the GPS Receiver window ends only your GPS connection; data 
may still be transferred.
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Displaying Your Phone Number

You can view your phone number in the Device Info & Diagnostics window 
(Menu > Device Info & Diagnostics).

Security

When it is disconnected, you can lock your USB modem so that others cannot use 
it to access your account. A four-digit lock code is needed to unlock the USB 
modem.

You can set the USB modem to lock: 

� Whenever Sprint Connection Manager is started (page 57).

– or –

� Immediately (without restarting Sprint Connection Manager) — useful if you 
are lending your USB modem and computer or leaving your computer for a 
short time (page 56).

Initial Lock Code 

The initial lock code value is determined by your service provider. 

For service provider configurations that do not require account activation, a 
default lock code is set at the factory to a value determined by the service provider. 
For assistance, contact Sprint (page 13). 

Configurations that use the Activation Wizard or IOTA set the initial lock code to 
the last four digits of your account phone number whenever a new phone number 
is activated.

After activation, you can change the lock code (page 58) from the initial value to 
any four-digit code you choose.

Note: The security lock code is reset to the last four digits of the phone number 
whenever an account is activated. This may change a custom value you 
have set.
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When the USB Modem Is Locked

When the USB modem is locked, you can:

� Unlock the USB modem (page 57).

� Power off the USB modem (page 45).

When the USB modem is locked, you cannot:

� Make data connections (the GO button is unavailable).

� Use Sprint Location Services.

� Run the Activation Wizard.

Locking the USB Modem

To lock the USB modem immediately: 

1. End any active connection. (You can lock the USB modem only when it is 
disconnected; page 39.)

2. If the Mobile Broadband window is not expanded, click  to expand it.

3. Click the  icon.

4. In the Enter User Lock Code window, enter the lock code, and click OK.

When the USB modem is locked, the Mobile Broadband window displays “Device 

locked,” and the lock icon is now . The GO button is unavailable.

Warning: If you forget the lock code, you will not be able to use the USB modem until 
you receive assistance from Sprint.

Tip: You can also set the USB modem to be locked upon startup of Sprint 
Connection Manager, as described next.



Section 3A: Your USB Modem: The Basics      57

Locking upon Sprint Connection Manager Startup
To set the USB modem to lock as soon as Sprint Connection Manager starts up: 

1. End any active connection. (You can lock the USB modem only when 
disconnected; see page 39.)

2. If the Mobile Broadband window is not expanded, click  to expand it.

3. Click the lock icon (  or , depending on the current lock status).

4. In the Enter User Lock Code window, enter the lock code, and select Relock 
modem when program exits.

5. Click OK.

Unlocking the USB Modem

When the USB modem is locked, the Mobile Broadband window displays “Device 

locked,” and the lock icon is .

To unlock the USB modem: 

1. If the Mobile Broadband window is not expanded, click  to expand it.

2. Click the  icon.

3. In the Enter User Lock Code window, enter the lock code, and click OK.

When the USB modem is unlocked, the Mobile Broadband window no longer 

displays “Device locked,” and the lock icon is .

Note: This setting takes effect only after you exit and restart Sprint Connection 
Manager.



58 Section 3A: Your USB Modem: The Basics

Changing the Lock Code

To change the lock code:

1. In the Sprint Mobile Broadband settings window (page 68), click 
User Lock Change.

The Change User Lock Code window is displayed:

2. Enter the current lock code.

3. Enter a new four-digit lock code.

4. Enter the new lock code for confirmation.

5. Click OK.

Accessing Links

For your convenience, Sprint Connection Manager includes links to Sprint 
products and services. To access these links:

1. In Sprint Connection Manager, click Menu.

2. Select Links.

Warning:  If you forget the lock code, you will not be able to use the USB modem until 
you receive assistance from Sprint.

Note: You cannot add or remove links from the Links menu. To add or remove links, 
use your Web browser.
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Uninstalling the Sprint Connection Manager Software

To remove the Sprint Connection Manager software from your computer, use the 
Add/Remove Programs utility built into your Windows operating system.

1. Exit Sprint Connection Manager (page 49).

2. Remove the USB modem. (See “Removing the USB Modem” on page 22.)

3. Select Start > Control Panel and select:

(Windows Vista) Programs and Features.
(Windows XP or Windows 2000) Add/Remove Programs.

The Windows Add/Remove Programs utility will start. Be sure the Change or 
Remove Programs feature is selected (default).

4. From the list, select Sprint Mobile Broadband (Sierra), and click Remove or 
Uninstall.
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Sec tion 3B

Menu Options

In This Section

� Sprint Connection Manager Menu

� System Tray Menu

This chapter describes each menu option you may encounter while using your 
Sprint Mobile Broadband USB modem and the Sprint Connection Manager 
software on your Windows computer.
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Sprint Connection Manager Menu

Clicking Menu or the  button, located in the upper left corner of 
Sprint Connection Manager, displays the Sprint Connection Manager menu.

The following table describes the menu options:

Note: Depending on your configuration and settings, not all menu options may be 
shown or enabled as described here.

Tip: You can also display the menu by positioning the cursor over the Menu text 
or the  button and then pressing the spacebar or Enter key on your 
keyboard. To hide the menu, press Esc, or click outside the menu.

Menu Item Description

Links  Access links to Sprint products and services. 

See “Accessing Links” on page 58.

Power Off 
Modem

Power off your USB modem.

See “Powering the USB Modem On and Off” on page 45.

Location & 
Search 
Services

Query the network for information on points of interest that 
are near your current location.

See “Sprint Location Services” on page 43.
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Alert Log View a record of all alerts (for example, connection errors) 
that have been received while establishing and maintaining 
connections. 

See “Viewing Alerts” on page 76.

Connection 
History

View a record of connections established using your USB 
modem (unavailable if the Connection History is empty, or if 
Keep Connection History [page 67] is not selected).

See “Viewing the Connection History” on page 75.

Device Info & 
Diagnostics

View information about your USB modem and run diagnostic 
tests. 

See “Running Diagnostics” on page 77.

Software 
Updates

Retrieve updates for Sprint Connection Manager and your 
USB modem. 

See “Updating the Software” on page 79.

Help Display the online Help, which has operating hints and step-
by-step instructions for getting the most from your USB 
modem. 

See “Online Help” on page 54.

About 
Sprint Mobile 
Broadband

Display brief information about the Sprint Connection 
Manager software. To close the window, click anywhere inside 
it. 

See “About Sprint Mobile Broadband” on page 80.

Settings Change the settings for Sprint Connection Manager. Contains 
submenu items:

� General: See “General Settings” on page 66.

� Sprint Mobile Broadband - Sierra Wireless: See “Sprint Mobile 
Broadband Settings” on page 68.

� Sprint Location Services: See “Sprint Location Services 
Settings” on page 71.

Exit  Exits Sprint Connection Manager.

Menu Item Description
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System Tray Menu

When you right-click the system tray icon ( ), a shortcut menu is displayed:

The following table describes the menu options:

Menu Item Description

Open/Close 
Sprint Mobile 
Broadband

Minimize Sprint Connection Manager (Close), or restore 
(Open) if Sprint Connection Manager is minimized.

Help Display the online Help.

About 
Sprint Mobile 
Broadband

Display brief information about the Sprint Connection 
Manager software. To close the window, click anywhere 
inside it.

Exit Exit Sprint Connection Manager.
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Sec tion 3C

Changing Sprint Connection Manager Settings

In This Section

� Settings Window

� General Settings

� Sprint Mobile Broadband Settings

� Sprint Location Services Settings

This chapter describes settings you can change to customize Sprint Connection 
Manager.
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Settings Window

From the Settings window, you can specify the settings for Sprint Connection 
Manager.

1. In Sprint Connection Manager, click Menu.

2. Select Settings.

3. From the drop-down list, select one of the following categories of settings:

� General (general behavior of Sprint Connection Manager; page 66)

� Sprint Mobile Broadband - Sierra Wireless (behavior of your Sprint Power 
Vision or Sprint Vision connection; page 68)

� Sprint Location Services (page 71)

4. Make the appropriate changes to the settings (described in the following 
pages).

5. To change other settings, repeat steps 3 and 4.

6. Click OK.

Note: This feature is temporarily unavailable if you have powered off the USB 
modem (page 45).

Note: Changes to the setting Launch when Windows starts apply only after you 
restart Windows. Changes to the setting Start in system tray apply only after 
you exit and restart Sprint Connection Manager.

Tip: You can also access the Settings window from the Connection History 
window (page 75): click File > Settings.
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General Settings

From the General option in the Settings window, you can specify settings that 
affect the general behavior of Sprint Connection Manager.
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The following table describes the options:

Menu Item Description

Play sound 
effects

Play a clicking sound whenever an action is made in 
Sprint Connection Manager.

Always on 
top

Keep Sprint Connection Manager visible on your screen 
regardless of which applications are open.

Start in 
system tray

Have Sprint Connection Manager start (minimized) in the system 
tray on startup. (See “Restoring Sprint Connection Manager” 
on page 49.)

Keep 
Connection 
History

Have Sprint Connection Manager keep a log of your data 
connections (page 75).

Launch when 
Windows 
starts

Have Sprint Connection Manager start automatically when 
Windows starts.

Tip: You can also set the Sprint Power Vision or Sprint Vision 
connection to launch automatically whenever available (see “GO 
automatically when ready” on page 69). These settings provide an 
“always-on” connection, as long as you have network coverage.

Check for 
updates once 
per month

Have Sprint Connection Manager automatically check for 
software updates (page 79).

Check Now Check for software updates immediately.

Note: During the software update, Sprint Connection Manager will 
close. Before you initiate the software update, finish any Web 
browsing, data transfers, and so on.

Note: Changes to the setting Launch when Windows starts apply only after you 
restart Windows. Changes to the setting Start in system tray apply only after 
you exit and restart Sprint Connection Manager.
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Sprint Mobile Broadband Settings

From the Sprint Mobile Broadband option in the Settings window, you can change 
the behavior of your Sprint Power Vision or Sprint Vision connection.
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The following table describes the options:

Menu Item Description

Always show 
Welcome 
Screens

Display a welcome screen upon a successful connection to the 
network.

GO 
automatically 
when ready

Automatically connect to the network after Sprint Connection 
Manager starts, or whenever Sprint Connection Manager 
loses the network connection.

To select GO automatically when ready, ensure that Enable 
Network Adapter (NDIS) (below) is not selected.

Tip: You can also set Sprint Connection Manager to start 
automatically (see “Launch when Windows starts” on page 67). 
These settings provide an “always-on” connection, as long as you 
have network coverage.

You can have a connection established automatically, without 
having to run Sprint Connection Manager. Ensure that 
GO automatically when ready is not selected, and select Enable 
Network Adapter (NDIS) (below). 

Enable 
Network 
Adapter 
(NDIS)

Make a connection automatically, without running 
Sprint Connection Manager—simply by starting whatever 
application you want to use (such as your Web browser or 
email application).

To select Enable Network Adapter (NDIS), ensure that GO 
automatically when ready (above) is not selected.

Note: Sprint Location Services are available only when 
Sprint Connection Manager is running.

Network 
Mode: 
Automatic

Attempt a Sprint Power Vision (1xEV-DO) connection and, if 
not successful, attempt the slower Sprint Vision (1X) 
connection.

Network 
Mode: 
1xEV-DO 
Only

Attempt only a Sprint Power Vision (1xEV-DO) connection.

Note: Sprint Location Services may not be supported. When in an 
area that has only Sprint Vision (1X) coverage, you won’t be able to 
connect to the network.
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Network 
Mode: 
1X Only

Attempt only a Sprint Vision (1X) connection (even when you 
have Sprint Power Vision [1xEV-DO] coverage, which provides 
faster data transmission speeds).

Note: When in an area that has only Sprint Power Vision (1xEV-DO) 
coverage, you won’t be able to connect to the network.

Roam Mode: 
Sprint

Disable roaming when you are not in the network coverage 
area. You will be able to connect only when you are in the 
network coverage area.

Roam Mode: 
Automatic

Allow roaming when you are not in the network coverage 
area.

Note: Roaming rates may apply. Roam Guard (page 51) can remind 
you of this.

Roam Mode: 
Roam Only

Allow only roaming.

Note: Roaming rates may apply. Roam Guard (page 51) can remind 
you of this. Sprint Location Services may not be available.

Roam Mode: 
Roam Guard

Display a warning message when you are about to establish a 
data connection while roaming. For more information, see 
“Roam Guard” on page 51.

Available only if Roam Mode is set to Automatic (page 70).

Note: If you proceed with the data connection, roaming rates may 
apply.

Activation 
Wizard

Used only when activating a USB modem, or when changing 
your USB modem’s phone number (page 25).

User Lock 
Change

Change the security lock code of the USB modem (page 58).

Auto Launch Optionally specify which application to automatically launch 
when a connection is established.

See “Auto-launch upon Network Connection” on page 52.

Menu Item Description
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Sprint Location Services Settings

From the Sprint Location Services option in the Settings window, you can change 
the behavior of Sprint Location Services. (For more information on Sprint Location 
Services, see page 43.)



72 Section 3C: Changing Sprint Connection Manager Settings

The following table describes the options:

Menu Item Description

Enable 
Location 
Services

Turn on support (by your USB modem) for Sprint Location 
Services.

Note: To use Sprint Location Services, your account must also be 
configured appropriately. If you are unable to use Sprint Location 
Services, see “Sprint Location Services Aren’t Working or Don’t Seem to 
Be Available” on page 96 or contact Sprint Customer Service (page 13).

Display GPS 
Receiver

Show or hide the GPS Receiver window (page 46).

Display GPS 
Welcome

Display a welcome window whenever you initiate 
Sprint Location Services.

Display 
'Location & 
Search 
Services' on 
the menu

Show or hide the Sprint Connection Manager menu item that 
displays the Sprint Nextel Location & Search window. For 
more information on this window, see “Sprint Location 
Services” on page 43.

Do not show 
NMEA Privacy 
Consent

Prevent a Privacy Consent Agreement window from appearing 
every time you use NMEA. For more information, see “What is 
NMEA?” on page 90 and “When do I need to use NMEA?” on 
page 90.

Do not show 
Privacy 
Consent for 
'Location & 
Search 
Services'

Prevent a Privacy Consent Agreement window from appearing 
every time you use the Location & Search Services menu.

Microsoft Live

MapQuest

Yahoo! Maps

Google Maps

Specify which mapping and search service (for example, 
Microsoft® Live, or Google™ Maps) your Web browser uses for 
Sprint Location Services.

Some mapping and search services may have data that is 
more current or accurate than that of other mapping and 
search services.
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Test GPS Verify that your USB modem is able to obtain data for 
Sprint Location Services:

1. Ensure that Network Mode (from the Sprint Mobile 
Broadband Settings window; page 68) is set to Automatic 
or 1X Only. (Sprint Location Services may not be available 
if Network Mode is set to 1xEV-DO Only.)

2. Ensure you are in the network coverage area (not 
roaming).

3. Click Test GPS.

The results (including the number of satellites, latitude, 
longitude, and elevation information) are displayed to the 
right of the Test GPS button.

Menu Item Description
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Section 3D

Tools

In This Section

� Viewing the Connection History

� Viewing Alerts

� Running Diagnostics

� Updating the Software

� About Sprint Mobile Broadband

This chapter describes various features you can use to view information about the 
Sprint Mobile Broadband USB modem and the Sprint Connection Manager 
software on your Windows computer.
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Viewing the Connection History

Connection History displays a record of connections established using your USB 
modem. You can sort records by connection name to easily distinguish between 
personal and business usage.

From this window you can also access the Settings window (page 65) (File > 
Settings).

To view the Connection History:

1. In Sprint Connection Manager, click Menu.

2. Select Connection History.

To sort the entries:

� Click the button that contains the title of the column you want to sort by. (You 
can reverse the sort order by clicking the button again.)

– or –

Click an option under the Sort menu.

To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.

Note: For connections to be recorded, Keep Connection History must be enabled 
(page 67).
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To copy one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries; to select all entries, select Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email message).

To delete all entries:

� Click the Clear button.

To delete one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries.)

2. Select Edit > Delete.

Viewing Alerts

The Alert Log displays a record of all alerts (for example, connection errors) that 
have been received while establishing and maintaining connections. You can use 
the Alert Log to help isolate and resolve connection issues.

To view the Alert Log:

1. In Sprint Connection Manager, click Menu.

2. Select Alert Log. (This menu option is unavailable if the alert log is empty.)

To sort the entries:

� Click the button that contains the title of the column you want to sort by. (You 
can reverse the sort order by clicking the button again.) 

– or –

Click an option under the Sort menu.
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To export the entries to a text file:

1. Select File > Export.

2. Specify a file name and path.

3. Click Save.

To copy one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries; to select all entries, select Edit > Select All.)

2. Select Edit > Copy.

3. Paste the entries (for example, into a text file or email message).

To delete all entries:

� Click the Clear button.

To delete one or more entries:

1. Select the entries. (Click a single entry, or hold down CTRL or SHIFT and click to 
select multiple entries.)

2. Select Edit > Delete.

Running Diagnostics

To identify problems when connecting to the network, use the Device 
Info & Diagnostics window. Device Info & Diagnostics evaluates issues with your 
USB port, port configuration, network signal strength, Sprint Connection 
Manager, and more. Once the program runs a diagnostics check, it recommends 
solutions.

The program also displays information such as your phone number.

Results of the diagnostics can be shared with a Sprint Customer Service Specialist, 
to assist that person with troubleshooting.

To access the Device Info & Diagnostics window:

1. Ensure the USB modem is inserted.

2. In Sprint Connection Manager, click Menu.

3. Select Device Info & Diagnostics.
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The tests automatically start when the window opens.

From the Device Info & Diagnostics window, you can view system information 
(page 79) and save the system information to an RTF (Rich Text Format) file.

From the Device Info & Diagnostics window, you can also update parameters in 
your USB modem:

� Click Update Data Profile. (If this button is not displayed, remove and reinsert 
the USB modem.)
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Displaying System Information

The System Information window displays:

� System Parameters: Information about your computer hardware and software.

� Installed Files: Files related to Sprint Connection Manager.

� Device Info & Diagnostics: Information about the USB modem (including its 
phone number), and results of various tests.

To display system information:

1. Select Menu > Device Info & Diagnostics.

2. In the Device Info & Diagnostics window, click System Information.

To save the information to a file (for example, if you are requested to send the report to 
your service provider representative):

1. In the System Information window, click Create Report.

2. Specify a file name and path.

3. Click Save.

Updating the Software

From time to time, Sprint may release updates for Sprint Connection Manager and 
your USB modem. These updates may add features or improve network 
performance.

To update the software:

1. Ensure you have a network connection.

2. In Sprint Connection Manager, click Menu. Select Software Updates. 

– or –

From the General option in the Settings window (page 65), click Check Now.

You can also set the software to automatically check for updates once a month:

1. In Sprint Connection Manager, click Menu and then select Settings.

2. Select Check for updates once per month.

Note: During the software update, Sprint Connection Manager will close. Before 
you initiate the software update, finish any Web browsing, data transfers, 
and so on.



80 Section 3D: Tools

About Sprint Mobile Broadband

The About Sprint Mobile Broadband window displays information about the 
Sprint Connection Manager software.

To display this window:

� In Sprint Connection Manager, click Menu and then select About Sprint Mobile 
Broadband. 

– or –

Right-click the Sprint Connection Manager icon ( ) in the system tray and, 
from the shortcut menu, select About Sprint Mobile Broadband.

To close this window, click anywhere inside it.

Tip: To display more information, you can run diagnostics (page 77).
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Sec tion 3E

Frequently Asked Questions (Windows)

In This Section

� What is Sprint Connection Manager?

� If the connection is “always on,” am I always being billed?

� How fast is the connection with Sprint Connection Manager?

� How can I optimize my settings to achieve the fastest speeds and 
conserve data when accessing my corporate network?

� Can I connect to a dial-up account like AOL or EarthLink?

� Once I connect to the network, how do I access my corporate network 
through a VPN?

� Why won’t my laptop go into hibernation mode when using my 
Sprint Mobile Broadband USB Modem?

� What is LBS?

� What is GPS?

� What is enhanced Local Search?

� How do I get the enhanced Local Search feature?

� Where do I find the enhanced Local Search feature?

� How do I use the enhanced Local Search feature?

� Where can I use GPS?

� What is GPS User Plane?

� What is GPS Control Plane?

� How do I enable/disable GPS?

� Will GPS work when Privacy is set to ON?

� Can I use Sprint Location Services if I have enabled NDIS?

� Do I need a GPS subscription to use GPS?

� Location-Based Services limitations
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� What GPS mode options are supported?

� What is GPS Basic?

� What is GPS Premium?

� What is the difference between GPS Basic and GPS Premium?

� What is a GPS application?

� What is NMEA?

� How do I configure a GPS application to use my GPS-capable device?

� When do I need to use NMEA?

� How do I start and stop NMEA?

� How do I configure my NMEA port?
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What is Sprint Connection Manager?

Sprint Connection Manager is software that lets you connect to the Sprint Power 
Vision or Sprint Vision network. Sprint Connection Manager takes advantage of 
the increased data speeds offered by the Sprint Mobile Broadband Network.

If the connection is “always on,” am I always being billed?

No. The connection to the network goes dormant after a period of inactivity, but 
the connection can be re-established faster than having to reconnect. Billing 
occurs only when data is passed across the network.

How fast is the connection with Sprint Connection 
Manager?

The Sprint Mobile Broadband Network allows you to connect to the Internet at 
speeds of up to 3.1 Mbps (1xEV-DO Rev. A), 2.4 Mbps (1xEV-DO Rev. 0), or 144 kbps 
(1X). Average connection speeds are:

� For 1xEV-DO Rev. A: between 600 kbps and 1.4 Mbps downlink from the 
network, and between 350 and 500 kbps uplink to the network;

� For 1xEV-DO Rev. 0: between 400 and 700 kbps downlink from the network, 
and between 40 and 80 kbps uplink to the network;

� For 1X: between 40 and 80 kbps.

These speeds are faster than dial-up connection speeds.
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How can I optimize my settings to achieve the fastest 
speeds and conserve data when accessing my corporate 
network?

Depending on your corporate email client, you can optimize your settings by doing 
the following:

� Work in “offline” mode, and connect only when you need to send or receive 
email.

� Remove the Preview Pane, or use the AutoPreview for headers only.

� Save attachments to a desktop folder and then open from that folder, rather 
than opening the attachment directly from the message.

For more information, see the user documentation of your email client.

Can I connect to a dial-up account like AOL or EarthLink?

No. The software does not support dial-up connections.

Once I connect to the network, how do I access my 
corporate network through a VPN?

Once you complete a wireless connection, you may need to launch an extranet 
client provided by your company and supply the appropriate user name and 
password to gain access. For support, contact your company help desk.

Why won’t my laptop go into hibernation mode when 
using my Sprint Mobile Broadband USB Modem?

If you’re using Windows 2000, you need to upgrade to Service Pack 4 from 
www.microsoft.com.

What is LBS?

LBS (Location-Based Services) is used to provide enhanced Local Search 
functionality via internet mapping services. For more information, see “What is 
enhanced Local Search?” on page 85.

http://www.microsoft.com
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What is GPS?

GPS stands for Global Positioning System, which is a system that uses a series 
of 24 geosynchronous satellites to provide location data.

GPS satellites transmit signals to equipment on the ground. GPS receivers 
passively receive satellite signals, but do not transmit.

Various GPS standards exist for the User Plane and Control Plane. For more 
information, see “What is GPS User Plane?” and “What is GPS Control Plane?” on 
page 86.

What is enhanced Local Search?

Enhanced Local Search is a quick, easy method to run, via Sprint Connection 
Manager, local search queries to find locations and directions to locations and 
businesses.

The enhanced Local Search feature uses LBS and allows you to search for Sprint 
Nextel stores, restaurants, banks, hotels, and so on, outdoors and (with GPS 
Premium) indoors. For more information, see “What is GPS Premium?” on page 89.

How do I get the enhanced Local Search feature?

The enhanced Local Search feature works only with GPS-capable data cards and 
the latest version of Sprint Connection Manager. The feature is available at no 
additional charge in the latest version of Sprint Connection Manager.

Where do I find the enhanced Local Search feature?

In Sprint Connection Manager, select Menu > Location & Search Services.

Note: Sprint Location Services may not be supported if Network Mode is set to 1xEV-DO Only. 
To use Sprint Location Services, ensure Network Mode is set to Automatic or 1XOnly.
Sprint Location Services are not supported if you're roaming (subject to change).
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How do I use the enhanced Local Search feature?

When running Sprint Connection Manager, select Menu > Location & Search 
Services. Some predefined, most frequently used queries are listed. There is also an 
option to run your own custom query; if you've previously entered search items, a 
drop-down list displays the last five items you've entered.

Where can I use GPS?

GPS works wherever there is both Sprint CDMA network access and GPS access.

What is GPS User Plane?

GPS User Plane is the ability to execute GPS requests at the subscriber level on the 
USB modem. In other words, the User Plane allows you to submit location-related 
queries to the network.

Compare to GPS Control Plane (see below).

What is GPS Control Plane?

GPS Control Plane is the ability to execute GPS requests at the network (server) 
level.

Compare to GPS User Plane (see above).

Note: In some locations where CDMA network access is available, GPS may not 
be available at this time. For the latest on service available by location, refer 
to Sprint Nextel Coverage maps.
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How do I enable/disable GPS?

By default, Sprint Location Services are disabled.

To enable Sprint Location Services:

1. In the Sprint Location Services settings window, select Enable Location Services.

2. If you will be using the GPS Receiver window (page 35), select Display GPS 
Receiver.

Will GPS work when Privacy is set to ON?

No. Setting Privacy to ON [by not accepting the Consent Privacy Agreement(s)] 
means you do not want your USB modem to be discoverable; thus, GPS is not 
enabled/started on the USB modem.

Can I use Sprint Location Services if I have enabled NDIS?

Yes. Sprint Location Services/GPS services are supported, whether or not you have 
selected Enable Network Adapter (NDIS).

Do I need a GPS subscription to use GPS?

For GPS Basic, you do not need a GPS subscription.

For GPS Premium, you need a GPS subscription.

For more information on GPS Basic and GPS Premium, see “What is GPS Basic?” 
and “What is GPS Premium?” on page 89.

Tip: To prevent Privacy Consent Agreements from appearing every time you use NMEA or 
the Location & Search Services menu, select Do not show NMEA Privacy Consent and Do 
not show Privacy Consent for 'Location & Search Services'.

Tip: An icon in the GPS Receiver window indicates the GPS/Privacy status (page 36).
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Location-Based Services limitations

To acquire a location fix, you must be connected to the Sprint network, (subject to 
change) not roaming, and, for the initial fix, in 1X coverage.

If you're outside with a clear view of the sky, the USB modem uses MS-Based 
position location technology. Weather conditions may affect your ability to get a 
clear view of the satellites and thus to acquire a GPS fix. MS-Based GPS (Basic) is 
for outdoor use only.

What GPS mode options are supported?

GPS on a Sprint data card works like any other GPS device. Sprint provides two 
types of GPS mode: GPS Basic, and GPS Premium.

For more information, see “What is GPS Basic?” and “What is GPS Premium?” on 
page 89.

What is GPS Basic?

Sprint GPS Basic supports GPS outdoors. Your USB modem requires an 
unobstructed view of GPS satellites (in the sky), and, like any other GPS device, 
might not perform well within forested areas or near tall buildings. 

Sprint GPS Basic is based on GPSOne™ standards and uses Location-Based Services 
for the first, fast, GPS fix. GPS coordinate values are made available to applications 
via a local GPS NMEA Com port.

Note: Location-Based Services use Advanced Forward Link Trilateration (AFLT). AFLT is a type 
of device-based position location technology. Unlike A-GPS, AFLT does not use GPS 
satellites to determine location. Instead, the device takes measurements of signals 
from nearby cellular base stations (towers) and reports the time/distance readings 
back to the network; the readings are then used to triangulate an approximate 
location of the device. In general, at least three surrounding base stations are 
required to get an optimal position fix.
AFLT accuracy may vary, depending on the geometry of the cell towers in your 
location.

Note: Sprint Location Services may not be supported if Network Mode is set to 1xEV-DO Only 
or (subject to change) if you are roaming. To use Sprint Location Services, ensure 
Network Mode is set to Automatic or 1XOnly, and ensure that you are in the network 
coverage area (not roaming).
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See also “What is NMEA?” on page 90 and “What is the difference between GPS 
Basic and GPS Premium?” on page 89.

What is GPS Premium?

GPS Premium supports GPS outdoors (as does GPS Basic) and additionally indoors 
(where no GPS satellites are available).

To use GPS Premium, you need a GPS subscription.

What is the difference between GPS Basic and GPS 
Premium?

GPS Basic is for outdoor use — similar to the capability of a regular GPS device.

GPS Premium is an enhanced GPS capability that allows GPS to be used indoors 
and outdoors. To use GPS Premium, you need a GPS subscription.

What is a GPS application?

A GPS application is an application that uses NMEA data to get regular location 
coordinate updates and values typically displayed in an application. (For more 
information on NMEA, see “What is NMEA?” [below].)

Examples of GPS applications are Microsoft Streets & Trips, and Microsoft 
MapPoint.

Note: At the time of this software release, this GPS mode option is not yet available.
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What is NMEA?

NMEA stands for “National Marine Electronics Association.”

NMEA 0183 is a standard protocol used by GPS devices to send and receive data.

NMEA output is composed of various strings. Sprint GPS data cards support the 
following strings:

� $GPGGA

� $GPRMC

� $GPGSA

� $GPGSV

See also “When do I need to use NMEA?”, “How do I start and stop NMEA?”, and 
“How do I configure my NMEA port?”, starting on page 90.

How do I configure a GPS application to use my 
GPS-capable device?

To configure a GPS application to use your GPS-capable device:

1. Start GPS NMEA (page 91).

2. Note the “GPS Port” value displayed in the expanded GPS Receiver window 
(page 35).

3. Configure your GPS application to use the same port. For help, see the 
documentation of the GPS application.

When do I need to use NMEA?

You need to use NMEA only when using a GPS application that uses an NMEA 
output stream. For more information, see “What is a GPS application?” on 
page 89.

Note: To ensure the best data performance of your USB modem, it’s recommended that 
you not activate the NMEA stream unless you are going to use it.
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How do I start and stop NMEA?

To start NMEA output:

1. Click GO in the GPS Receiver window (page 35).

2. Read and accept the Privacy Consent Agreement.

To stop NMEA output, you have several options:

� In the GPS Receiver window, click Stop.

� In the Mobile Broadband window, click Stop.

� Exit Sprint Connection Manager.

� If you have started the GPS application before you started NMEA output: exit 
the GPS application.

How do I configure my NMEA port?

At the time of this software release, you cannot specify which port Windows uses 
for NMEA output. Windows automatically uses the next available port.

You can, however, configure the GPS application to use the NMEA Com port that 
Windows is using (page 90).

Note: To ensure the best data performance of your USB modem, it’s recommended that 
you not activate the NMEA stream unless you are going to use it.

Tip: You can turn off the display of the NMEA Privacy Consent Agreement (from the 
Sprint Location Services settings window)



92 Section 3F: Troubleshooting Tips (Windows)

Sec tion 3F

Troubleshooting Tips (Windows)

In This Section

� Problems, Causes, and Solutions

� GO Button Is Unavailable

� Searching for Service

� Cannot Connect to the Network

� PWR LED Goes Off and On, and Then Stays Red

� Sprint Location Services Aren’t Working or Don’t Seem to Be Available

� Could Not Prepare Data Services

� Unable to Prepare Data Services

� Sprint Connection Manager Stops Working After Upgrading Windows

This section helps you diagnose and solve common problems you may experience 
while using your Sprint Mobile Broadband USB modem and the Sprint Connection 
Manager software on a Windows computer.
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Problems, Causes, and Solutions

When properly installed, the Sprint Mobile Broadband USB modem is a highly 
reliable product.

Most problems are caused by one of these issues:

� Network coverage is not available (because of your “Network Mode” settings 
[page 68], or because you are outside the network, or because of an account or 
network problem).

� The drivers were not properly installed because of a problem with your 
computer’s USB slot.

� System resources required by the USB modem are being used by other devices.

Tips when troubleshooting problems with your USB modem and software:

� Ensure your USB modem is inserted, not locked (page 56), and not powered off 
(page 40).

� Ensure the PWR LED is green.

� To determine the connection status, use the icons in the system tray (page 42), 
and icons in the Mobile Broadband window (page 34) and GPS Receiver window 
(page 36), and messages in the Mobile Broadband window (page 38) and GPS 
Receiver window (page 41).

� The alert log might indicate the nature of the problem (page 76).

� Run diagnostic tools supplied with Sprint Connection Manager (page 77).

� Check the Frequently Asked Questions (Windows) (page 81).

� Use the resources listed in “Getting Help” (page 12).

� If Sprint Connection Manager stopped working after you’ve upgraded to a 
different version of Windows, see “Sprint Connection Manager Stops Working 
After Upgrading Windows” on page 97.

If, after reading this section, you are unable to resolve a problem, please visit 
www.sprint.com or contact Sprint Customer Service. (See “Getting Help” on 
page 12.)

http://www.sprint.com
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GO Button Is Unavailable

Ensure the USB modem is properly inserted, not locked (page 56), and not 
powered off (page 40).

If the Mobile Broadband window displays “Searching for service” for a long period 
of time (for example, several minutes), see “Searching for Service” below.

If Roam Mode is set to Sprint, ensure you are in the network coverage area (not 
roaming), or change the setting (page 70). (You may be subject to roaming rates.)

Searching for Service

If the Mobile Broadband window displays “Searching for service” for a long period 
of time (for example, several minutes), try one of the following: 

� Try reorienting your computer, or try adjusting the angle of the USB modem’s 
USB connector (see the picture on page 19).

� If you are inside a building or near a structure that may be blocking the signal, 
change the position or location of your computer.

� If Roam Mode is set to Sprint, ensure you are within the network coverage area, 
or change the Roam Mode setting. (You may be subject to roaming rates.)

� If Roam Mode is set to Roam Only, ensure you are roaming, or change the 
Roam Mode setting.

� If Network Mode is set to 1X Only, and only 1xEV-DO coverage is available, either 
move to an area that has 1X coverage, or change the setting to Automatic or 
1xEV-DO Only. Note: With the setting 1xEV-DO Only, Sprint Location Services 
may not be supported.

� If Network Mode is set to 1xEV-DO Only, and only 1X coverage is available, either 
move to an area that has 1xEV-DO coverage, or change the setting to Automatic 
or 1X Only.

� Check with Sprint — a network or account problem may be preventing the USB 
modem from obtaining service.
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Cannot Connect to the Network

If you’re having problems connecting, or there’s no Sprint Power Vision (1x-EVDO) 
coverage in your area, set Network Mode to 1X Only and try to establish a 
connection.

If the connection is dropped as soon as it is established:

� Charge the battery for at least 30 minutes if the PWR LED is red. (If the 
connection still gets dropped as soon as it is established, continue with the 
following steps.)

– or –

1. Select:

(Windows Vista) Start > Control Panel > Network and Sharing Center > 
Manage Network Connections
(Windows XP) Start > Control Panel > Network Connections
(Windows 2000) Start > Settings > Control Panel > Network and Dial-Up 
Connections

2. Right-click Sprint Mobile Broadband - Sierra Wireless, and select Properties.

3. Select:

(Windows Vista) Options, and select PPP Settings.
(Windows XP) Networking tab, and select Settings.

4. Ensure that “Enable LCP Extensions” is selected and “Negotiate multi-link for 
single link connections” is not selected.

5. Click OK.

PWR LED Goes Off and On, and Then Stays Red

This situation may occur under extreme usage conditions when you’re 
transmitting data in a coverage area with a weak signal.

1. Wait until the PWR LED turns green.

2. Resume your connection.

� If the PWR LED still goes off, and then comes on again and stays red, charge 
the battery for at least 30 minutes.
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Sprint Location Services Aren’t Working or Don’t Seem to Be 
Available

If Sprint Location Services aren’t working or don’t seem to be available, check 
whether you have, in the Settings window (page 65), a Sprint Location Services 
option in the drop-down list.

� If the drop-down list does not have the Sprint Location Services option, then 
your account, your USB modem, or both are not configured to support 
Sprint Location Services; contact Sprint Customer Service (page 13).

– or –

1. Select the Sprint Location Services option from the drop-down list and ensure 
that Enable Location Services and Display 'Location & Search Services' on the menu 
are selected. (If a Privacy Consent Agreement is displayed, you must read and 
accept it.)

2. If you will be using NMEA, select Display GPS Receiver. (For more information on 
NMEA, see “What is NMEA?” on page 90.)

3. Ensure that Network Mode (in the Sprint Mobile Broadband settings window) 
is set to Automatic or 1X Only. (Sprint Location Services may not be available if 
Network Mode is set to 1xEV-DO Only.)

4. Ensure you are in the network coverage area (not roaming). For the initial fix, 
you must be in 1X coverage.

5. To verify that your USB modem is able to obtain data for Sprint Location 
Services, in the Sprint Location Services settings window, click Test GPS.

6. If the results show the number of satellites and valid latitude, longitude, and 
elevation information, then check that the GPS application (for example, 
street mapping application) is configured to use the correct port. (The port 
number that the GPS application should use is displayed in the GPS Receiver 
window [page 35].)

For help on checking which port the GPS application is configured to use, see 
the documentation of the GPS application.

7. If the GPS application is configured to use the correct port, but the application 
doesn't seem to be reporting correct results, then there may be a problem 
with the GPS application.
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Could Not Prepare Data Services

See “Unable to Prepare Data Services” (page 97).

Unable to Prepare Data Services

The USB modem was unable to access the IOTA server to obtain data account 
parameters for you. This may be because the signal strength is poor or because the 
IOTA server is not responding.

� Confirm you have sufficient signal strength. Try the actions listed for “Searching 
for Service” (page 94).

� Contact Sprint for assistance (page 13).

This message may indicate that your system does not support 128-bit encryption 
for high-security access to data provisioning. You will not be able to complete the 
activation of data services until you upgrade your system’s security. (See “High 
Encryption Requirements [Windows]” on page 10.)

Sprint Connection Manager Stops Working After 
Upgrading Windows

If you’ve upgraded Windows, and Sprint Connection Manager stopped working:

1. Uninstall Sprint Connection Manager (page 59).

2. Reinstall Sprint Connection Manager (page 17).

Note: The message may appear as “Could not prepare data services. Please contact...”

Note: After the following steps, any changes you made to Sprint Connection 
Manager settings will be lost; you will have to reapply the changes.
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Sec tion 4A

Installing and Using the Software on a Mac Computer

In This Section

� Getting Started

� Installing the Software on a Mac

� Installing the Drivers

� USB Modem Activation and Provisioning

� Connecting to the Sprint Network

� Icons and Text in Watcher Lite

� Menu Options

� Attaching an External Antenna

� Removing Your USB Modem

� Sprint Service Areas

� Manage Your Account Online

� Troubleshooting Tips (Mac)

� Frequently Asked Questions

This section explains how to install and use your Watcher Lite software and 
Sprint Mobile Broadband USB modem on a Mac computer.
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Getting Started

Before you can use your USB modem, you must first install the USB modem’s 
software and configure the USB modem for your computer. The installation 
process consists of:

� Software installation - Installing the Watcher Lite software on your Mac 
computer.

� Insertion of the rechargeable battery into the USB modem

� USB modem insertion and driver installation - Starting the Watcher Lite software 
and inserting the USB modem, which automatically installs the drivers on your 
computer.

� USB modem activation and provisioning - Activating your Sprint account and 
configuring the USB modem to use your account.

For technical support issues, please contact Apple. If you can’t recall your lock 
code, contact Sprint Customer Service.

The Sprint Mobile Broadband USB modem is supported on a MacBook™, MacBook 
Pro, PowerBook® G4, Power Mac® G5, or desktop iMac computer running Mac 
OS X version 10.4 or newer.

To check your version, from the Apple menu ( ) choose About This Mac. If your 
version is earlier than 10.4, then:

� Visit  www.apple.com/downloads/macosx/apple  for upgrading instructions.
– or –

1. In Finder™, choose Go > Applications > System Preferences.

2. Double-click the System Preferences icon.

3. Double-click Software Update.

4. Click Check Now.

If your USB modem has not been activated, you may also need access to a 
telephone.

The software and drivers are on the CD included in your package. (To get the latest 
drivers and software, you can always go to www.sprint.com/downloads.)

CAUTION: Do not insert the USB modem into your computer’s USB slot before 
installing the software.

Note: As part of the installation process you will be prompted to restart your 
computer; save any open documents.

www.apple.com/downloads/macosx/apple
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Installing the Software on a Mac

To install the Watcher Lite software on your Mac computer:

1. If your USB modem has not yet been activated, ensure you are in the network 
coverage area (not roaming).

2. Insert the installation CD into your CD-ROM drive.

3. On the Mac desktop, double-click the Watcher Lite CD icon:

4. In the WL... Finder window, double-click INSTALLER.dmg.

5. In the Sierra Wireless Watcher Lite Finder window, double-click 
SierraWirelessWatcherLiteInstall.mpkg.

6. In the Welcome to the Sierra Wireless Watcher Lite Installer window, click 
Continue.

Note: The Mac software (Watcher Lite) currently does not support Sprint Location 
Services.
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7. In the “Select a Destination” window, choose a destination volume. A green 
vertical arrow indicates which volume(s) you can install the software onto. If 
more than one volume has a green vertical arrow, select the volume that has 
the active operating system.

8. Click Continue.

9. In the “Easy Install on ...” window, click Install. 

10. If the Authenticate window appears, enter your Mac user name and password, 
and then click OK.

11. In the window with the message that you will have to restart your computer, 
click Continue Installation.
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12. Click Restart. 

13. After your computer restarts, run Watcher Lite: in Finder, choose Go > 
Applications > Sierra Wireless Watcher.

Watcher Lite should start:

Installing the Drivers

To install the drivers on your Mac computer:

1. Slide the front panel off the USB modem.

2. Hold the battery so that the side with two white arrows faces up and the gold 
contact points on the end of the battery line up with the gold contact points 
on the USB modem. Insert the battery into the USB modem.

3. Slide the front panel onto the USB modem until the panel clicks into place.

Warning: To avoid the risk of explosion, use the same battery model when replacing 
the battery. Properly dispose of the used battery.
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4. Slide the lever on the bottom of the USB modem in the direction indicated by 
the triangle to release the USB modem’s USB connector.

5. Adjust the USB connector to the desired angle. (The USB connector is 
adjustable to three positions—approximately 90, 135, and 160 degrees. Do 
not force the hinge past the last position—this may break the connector.)

6. Gripping both sides of the USB modem, insert it into your computer’s USB slot.

Alternatively, you can attach the USB extension cable to your computer’s USB 
slot, and then connect the USB modem to the USB extension cable.

When the USB modem is properly inserted, the PWR LED is lit, and the USB 
modem’s battery starts to charge.

IMPORTANT! When inserting or removing your USB modem, always grip the USB 
modem by its sides, as this prevents damage to the USB modem.

Note: If your computer’s USB slot is vertical, use the USB extension cable. 
Do not insert the USB modem or USB extension cable into a USB hub or a 
USB slot on a keyboard.

Warning: If the orientation of your computer’s USB slot or the thickness of your 
computer are such that pressure is applied to the USB modem’s end or 
side (as shown by the red circles in the drawings below), you may 
damage the USB modem or your computer. In such cases, do not insert 
the USB modem directly into your computer’s USB slot; use the USB 
extension cable instead.
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7. If the New Port Detected window appears, click Continue.

8. If the Authenticate window appears, enter your Mac user name and password, 
and then click OK.

Watcher Lite displays a status message or the “Device Not Activated” window.

9. Allow the battery to charge for approximately two hours before closing the 
window or making a selection in it.

USB Modem Activation and Provisioning

After you have charged the battery for approximately two hours, use the following 
table to determine your next actions:

Text/window 
displayed

Description/next action

“Disconnected” Your USB modem is preactivated. You are ready to connect to 
the network (in Watcher Lite, click Connect).

� Proceed to “Connecting to the Sprint Network” on 
page 110.

“Device is 
Locked”

Your USB modem is preactivated. Unlock the USB modem:

1. If the Unlock Device window is not displayed: from the 
Extras item on the Sierra Wireless Watcher menu, choose 
Unlock Device.

2. In the Unlock Device window, enter the lock code (PIN), 
and click OK.

� If you can’t recall your lock code, try using the last four 
digits of your USB modem's phone number. If this doesn’t 
work, call Sprint Customer Service at 1-888-788-4727 
(business use) or 1-888-715-4588 (personal use).

3. Proceed to “Connecting to the Sprint Network” on 
page 110.
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Activation Assistant

The Activation Assistant will guide you through the activation process if your USB 
modem is not preactivated.

To set up your account, you will be contacting Sprint.

Before you call Sprint, have these things ready:
� A phone

� Your USB modem

� The city and state where the USB modem will be primarily used

� A pen and paper to write down your account information. Your package 
includes a printed Getting Started guide, where you can record this 
information.

“Device Not 
Activated” 
window

Your USB modem is not activated.

� Click Yes to indicate that you’d like to activate your USB 
modem. Watcher Lite will display “Updating User Profile.”

If provisioning is successful, Watcher Lite displays 
“Disconnected,” after which you are ready to connect to the 
network (click Connect). Proceed to “Connecting to the Sprint 
Network” on page 110.

– or –

If the Data Provisioning window displays “Provisioning failed,” 
use the Activation Assistant (below).

“Not activated” Your USB modem is not activated.

� Use the Activation Assistant (below).

Note: If you close the Activation Assistant before finishing the USB modem 
activation, you can start the Activation Assistant later (from the Extras item 
on the Sierra Wireless Watcher menu, choose Activation).

Text/window 
displayed

Description/next action
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When you call Sprint, Sprint Customer Service will help you select your service 
plan and guide you through the activation process. They will also provide you with 
this information:

� Your USB modem’s activation code (gives you access to configure the account)

� Your USB modem’s phone number (MDN)

� Your USB modem’s MSID (Mobile System ID) code, used for WLNP (Wireless 
Local Number Portability) and to determine whether you are “home” or 
“roaming”

To activate your USB modem and account:

1. From the Extras item on the Sierra Wireless Watcher menu, choose Activation.

2. In the Activation Assistant window, click Continue.

3. Call Sprint at the appropriate number displayed in the Activation Assistant. 

4. Follow the instructions of the account representative to activate your USB 
modem.

After Sprint sets up your account on the network, your USB modem is 
activated.

5. To complete the activation process, enter the information (from the account 
representative) into the fields on the screen.

6. From the Extras item on the Sierra Wireless Watcher menu, choose Data 
provisioning.

7. In the Data Provisioning window, click OK.

The USB modem then retrieves the updates to your account. Watcher Lite will 
display “Updating User Profile,” then “Disconnected,” after which you are 
ready to connect to the network (click Connect). Proceed to the next section 
(“Connecting to the Sprint Network”).
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Connecting to the Sprint Network

To connect to the Sprint network:

� In Watcher Lite, click Connect.

Once you're connected to the network, Watcher Lite shows the amount of time 
you've been connected, and the amount of data received (Rx) and transmitted 
(Tx).

To end your network connection:

� In Watcher Lite, click Disconnect.

Icons and Text in Watcher Lite

Depending on the USB modem and connection state, Watcher Lite may display 
some of the following icons and text:

Icon/text Description

CDMA network signal strength, indicated by the number of bars.

You are not in coverage.

You are in 1X and 1xEV-DO Rev. 0 coverage.

You are in 1X and 1xEV-DO Rev. A coverage.

You are in 1X coverage.

You are in 1xEV-DO Rev. 0 coverage.

You are in 1xEV-DO Rev. A coverage.

You are roaming. Roaming charges may apply.

You are in the network coverage area (not roaming).
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Menu Options

From the Extras item on the Sierra Wireless Watcher menu, you can:

� Activate your USB modem (page 108)

� Provision your USB modem (page 109)

� Lock/unlock your USB modem (page 107)

� View information about the USB modem

� View, configure, and use the data and VPN connections available on your 
computer (for example, WWAN)

Attaching an External Antenna

You can improve the signal strength by attaching an external antenna (sold 
separately).

To attach an external antenna:

1. Remove the USB modem from your computer (page 112).

2. Flip open the rubber tab on the side of the USB modem.

Disconnected Ready to connect to the network. To connect, in Watcher Lite click 
Connect.

Connected Connected to the network.

No device 
detected

Ensure the USB modem is properly inserted into your computer.

Not activated To use your USB modem, you must activate it.

� Use the Activation Assistant (page 108).

Device is 
Locked

From the Extras item on the Sierra Wireless Watcher menu, choose 
Unlock Device.

Rx Amount of data received from the network.

Tx Amount of data transmitted to the network.

Icon/text Description
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3. Hold the antenna cable by the connector (end) part, and carefully insert the 
connector part of the cable into the corresponding connector on the USB 
modem.

4. Reinsert the USB modem into your computer.

Removing Your USB Modem

To remove the USB modem from your Mac:

1. End your network connection, as described in “Connecting to the Sprint 
Network” on page 110.

2. Remove the USB modem from your computer’s USB slot by gripping both sides 
of the USB modem and pulling straight out.

Sprint Service Areas

Interested in where you can use your new USB modem? Check out the most 
up-to-date coverage maps at www.sprint.com.

Manage Your Account Online

With Sprint Customer Service, you can visit www.sprint.com  to manage your Sprint 
account.

Once you sign on, you can:

� View the details of your Sprint service plan.

� Find out how much data you have used and how many megabytes are 
remaining in your plan.

� View your current and previous three months’ invoices.

� Make a payment.

� Find out about Sprint products and services.

IMPORTANT! When inserting or removing your USB modem, always grip the USB 
modem by its sides, as this prevents damage to the USB modem.

www.sprint.com
www.sprint.com
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Troubleshooting Tips (Mac)

When properly installed, the Sprint Mobile Broadband USB modem is a highly 
reliable product.

Most problems are caused by one of these issues:

� Network coverage is not available (because you are outside the network, or 
because of an account or network problem).

� The drivers were not properly installed because of a problem with your 
computer’s USB slot.

Tips when troubleshooting problems with your USB modem and software:

� Ensure your USB modem is inserted, and not locked (page 107).

� Ensure the PWR LED is green.

� Check the Frequently Asked Questions (page 114).

� Use the resources listed in “Getting Help” (page 12).

If, after reading this section, you are unable to resolve a problem, please visit 
www.sprint.com or contact Sprint Customer Service. (See “Getting Help” on 
page 12.)

“Connect” Button Is Unavailable

If nothing seems to happen when you click the button, ensure the USB modem is 
properly inserted, and not locked. If Watcher Lite displays “Device Is Locked,” see 
page 107.

Searching for Service

If Watcher Lite displays “Searching for service” for a long period of time (for 
example, several minutes), try one of the following: 

� Try reorienting your computer, or try adjusting the angle of the USB modem’s 
USB connector (see the picture on page 106).

� If you are inside a building or near a structure that may be blocking the signal, 
change the position or location of your computer.

� Check with Sprint — a network or account problem may be preventing the USB 
modem from obtaining service.

Note: In some cases, the Connect button can establish a connection to the 
network, even if the button seems unavailable.

http://www.sprint.com
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Cannot Connect to the Network

If the connection is dropped as soon as it is established, charge the battery for at 
least 30 minutes if the PWR LED is red.

PWR LED Goes Off and On, and Then Stays Red

This situation may occur under extreme usage conditions when you’re 
transmitting data in a coverage area with a weak signal.

1. Wait until the PWR LED turns green.

2. Resume your connection.

� If the PWR LED still goes off, and then comes on again and stays red, charge 
the battery for at least 30 minutes.

Frequently Asked Questions

What is Watcher Lite?

Watcher Lite is software that lets you connect to the Sprint Power Vision or 
Sprint Vision network. Watcher Lite takes advantage of the increased data speeds 
offered by the Sprint Mobile Broadband Network.

Does the Watcher Lite software support LBS?

No. The Watcher Lite software does not support LBS (Location-Based Services).

If the connection is “always on,” am I always being billed?

No. The connection to the network goes dormant after a period of inactivity, but 
the connection can be re-established faster than having to reconnect. Billing 
occurs only when data is passed across the network.
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How fast is the connection with Sprint Connection Manager?

The Sprint Mobile Broadband Network allows you to connect to the Internet at 
speeds of up to 3.1 Mbps (1xEV-DO Rev. A), 2.4 Mbps (1xEV-DO Rev. 0), or 144 kbps 
(1X). Average connection speeds are:

� For 1xEV-DO Rev. A: between 600 kbps and 1.4 Mbps downlink from the 
network, and between 350 and 500 kbps uplink to the network;

� For 1xEV-DO Rev. 0: between 400 and 700 kbps downlink from the network, 
and between 40 and 80 kbps uplink to the network;

� For 1X: between 40 and 80 kbps.

These speeds are faster than dial-up connection speeds.

How can I optimize my settings to achieve the fastest speeds and 
conserve data when accessing my corporate network?

Depending on your corporate email client, you can optimize your settings by doing 
the following:

� Work in “offline” mode, and connect only when you need to send or receive 
email.

� Remove the Preview Pane, or use the AutoPreview for headers only.

� Save attachments to a desktop folder and then open from that folder, rather 
than opening the attachment directly from the message.

For more information, see the user documentation of your email client.

Once I connect to the network, how do I access my corporate 
network through a VPN?

Once you complete a wireless connection, you may need to launch an extranet 
client provided by your company and supply the appropriate user name and 
password to gain access. For support, contact your company help desk.

Can I connect to a dial-up account like AOL or EarthLink?

No. The software does not support dial-up connections.



116



Technical Specifications and 
Regulatory Information

Section 5



118



Section 5A: Technical Specifications      119

Sec tion 5A

Technical Specifications

In This Section

� LED Operation

� Radio Frequency and Electrical Specifications

� Software Specifications

� Environmental Specifications

� Mechanical Specifications

This section describes the LED and various specifications of your Sprint Mobile 
Broadband USB modem.
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LED Operation

Your USB modem has two LED lights. The LEDs operate as follows:

LED State Indicates

Data Off The USB modem has no power. The USB modem 
may not be completely inserted into the computer, 
the computer may be in suspend mode (Windows) 
or sleep mode (Mac); this mode powers down the 
USB modem.

 Solid 
green

The USB modem has power, has found a signal, and 
is ready to connect.

Green, 
blinking 
slowly

The USB modem is powering up, or no service is 
available. See “Searching for Service” on page 94 (if 
you’re running Windows), or “Searching for Service” 
on page 113 (if you’re running Mac).

Green, 
blinking 
rapidly

The USB modem is sending or receiving data.

PWR Off The USB modem has no power. The USB modem 
may not be completely inserted into the computer, 
the computer may be in suspend mode (which 
powers down the USB modem), or, if you’re running 
Windows, you have powered the USB modem off 
(page 45).

Red The USB modem has power; the battery is low.

Charge the battery by inserting the USB modem into 
the USB slot of your computer. Alternatively, 
connect the USB modem to the USB extension cable, 
and attach the USB extension cable to your 
computer.

Green The USB modem has power; the battery is charged.
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Radio Frequency and Electrical Specifications

Approvals Compliant with:

IS-2000 Release 1.0 (CDMA (1X), IS-707-A Data, IS-856 
(CDMA 1xEV-DO), IS-866, IS-878, IS-890, 
CDMA Development Group

FCC (ID: N7N-MC5725U)

Industry Canada (ID: 2417C-MC5725U)

Voltage +5.0 Vdc from USB slot

Current Maximum:  500 mA (from USB port)

Typical data call current (talk mode), at 3.3 V:

285 mA (1X)

295 mA (1xEV-DO)

Standby: 2.75 mA (1xEV-DO/IS-2000 hybrid mode), 
at 3.3 V

Transmitter 
power

200 mW (+23 dBm)

Transmit PCS:  1805 to 1870 MHz

Cellular:  824 to 849 MHz

Receive PCS:  1715 to 1780 MHz

Cellular:  868 to 894 MHz

GPS:   1575.42 MHz

Channel 
spacing

1.25 MHz

Frequency 
stability

±150 Hz
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Software Specifications

CDMA 
specification

IS-2000 Release 0

Data service IS-707A

SMS (IS-637) Not supported

FAX Not supported

IOTA Supported

OTASP (IS-683A, 
IS-683B, IS-683C)

Supported

OTAPA Supported

PRL (preferred 
roaming list)

Supported

Authentication Supported

Voice Not supported

NAM Single

E911 Not supported

Position Location Supported on Windows only (Mobile Station based)

TTY/Accessibility Not supported

Mobile IP Supported
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Environmental Specifications

Mechanical Specifications

Operating 
temperature

-10 to +60°C

Storage 
temperature

-20 to +85°C

Humidity 85%, non-condensing

Vibration Random vibration, 10 to 1000 Hz, nominal 6G RMS in 
each of 3 mutually perpendicular axes.

Test duration of 60 minutes for each axis, for a total test 
time of 3 hours (non-operating).

Drop 1 m on concrete on each of 6 faces, 2 times

Dimensions
(W x L x H)

39 mm x 93 mm x 20 mm

Power button Not supported

Headset jack Not supported

LED Red/green
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Sec tion 5B

Regulatory Information

In This Section

� Regulatory Notices

� Patents

� Trademarks

� Copyright

� Limitation of Liability

� Additional Information and Updates

This section contains important regulatory notices about your Sprint Mobile 
Broadband USB modem, and also patent and other information.
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Regulatory Notices

The design of the AirCard 595U USB modem complies with U.S. Federal 
Communications Commission (FCC) and Industry Canada (IC) guidelines 
respecting safety levels of radio frequency (RF) exposure for portable devices, 
which in turn are consistent with the following safety standards previously set by 
Canadian, U.S. and international standards bodies:

� ANSI / IEEE C95.1-1999, IEEE Standard for Safety Levels with Respect to Human 
Exposure to Radio Frequency Electromagnetic Fields, 3kHz to 300 GHz

� National Council on Radiation Protection and Measurements (NCRP) Report 86, 
1986, Biological Effects and Exposure Criteria for Radio Frequency 
Electromagnetic Fields

� Health Canada, Safety Code 6, 1999, Limits of Human Exposure to Radio 
frequency Electromagnetic Fields in the Frequency Range from 3 kHz to 300 GHz

� International Commission on Non-Ionising Radiation Protection (ICNIRP) 1998, 
Guidelines for limiting exposure to time-varying electric, magnetic, and 
electromagnetic fields (up to 300 GHz)

FCC ID: N7N-MC5725U

CAUTION: The AirCard 595U USB modem has been tested for compliance with 
FCC/IC RF exposure limits in the laptop computer(s) configurations with a 
horizontal USB slot and can be used in laptop computers with substantially similar 
physical dimensions, construction, and electrical and RF characteristics. This USB 
modem must not be colocated or operated in conjunction with any other antenna 
or transmitter. Use of this device in any other configuration may exceed the FCC RF 
Exposure compliance limit. Note: If this USB modem is intended for use in any 
other portable device, you are responsible for separate approval to satisfy the SAR 
requirements of Part 2.1093 of FCC rules.

WARNING (EMI) - United States FCC Information - This equipment has been tested 
and found to comply with the limits for a class B computing device peripheral, 
pursuant to Parts 15, 22, and 24 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential 
installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communication. However, there is no guarantee that 
interference will not occur in a particular installation.
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If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

� Reorient or relocate the receiving antenna

� Increase the separation between the equipment and receiver

� Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected

� Consult the dealer or an experienced radio/TV technician for help

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
condition that this device does not cause harmful interference.

CAUTION: Any changes or modifications not expressly approved by Sprint 
Communications Company L.P. could void the user’s authority to use the 
equipment.

WARNING (EMI) - Canada: This digital apparatus does not exceed the Class B limits 
for radio noise emissions from digital apparatus as set out in the interference 
causing equipment standard entitled “Digital Apparatus,” ICES-003 of the 
Department of Communications.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables 
aux appareils numériques de Classe B préscrites dans la norme sur le matériel 
brouilleur: “Appareils Numériques,” NMB-003 édictée par le ministre des 
Communications.

If you have purchased this product under a United States Government contract, it 
shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of Defense 
Federal Acquisitions Regulations (DFARs) Section 252.227-7013 for Department of 
Defense contracts, and as set forth in Federal Acquisitions Regulations (FARs) 
Section 52.227-19 for civilian agency contracts or any successor regulations. If 
further government regulations apply, it is your responsibility to ensure 
compliance with such regulations.
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Patents

Portions of this product are covered by some or all of the following US patents:

5,515,013 5,629,960 5,845,216 5,847,553 5,878,234

5,890,057 5,929,815 6,169,884 6,191,741 6,199,168

6,339,405 6,359,591 6,400,336 6,516,204 6,561,851

6,643,501 6,653,979 6,697,030 6,785,830 6,845,249

6,847,830 6,876,697 6,879,585 6,886,049 6,986,171

6,985,757 7,023,878 7,053,843 7,106,569 7,145,267

7,200,512 D442,170 D459,303 

and other patents pending.

Licensed by QUALCOMM Incorporated under one or more of 
the following United States patents and/or their counterparts 
in other nations:

4901307 5056109 5101501 5109390 5228054

5267261 5267262 5337338 5414796 5416797

5490165 5504773 5506865 5511073 5535239

5544196 5568483 5600754 5657420 5659569

5710784 5778338

Manufactured or sold by Sierra Wireless or its licensees under one or more patents 
licensed from InterDigital Group.
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Trademarks

SPRINT and other trademarks are trademarks of Sprint Nextel. 

AirCard® and “Heart of the Wireless Machine”® are registered trademarks of Sierra 

Wireless. Watcher® is a trademark of Sierra Wireless, registered in the European 
Community.

Sierra Wireless, the Sierra Wireless logo, and the red wave design are trademarks 
of Sierra Wireless.

Windows® is a registered trademark of Microsoft Corporation.

Mac OS is a trademark of Apple Inc., registered in the U.S. and other countries.

QUALCOMM® is a registered trademark of QUALCOMM Incorporated.

All other trademarks are property of their respective owners.

Copyright

©2007 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. SPRINT and other trademarks are trademarks of 
Sprint Nextel.

©2007 Sierra Wireless. All rights reserved.

Document 2130934 Revision 1.0
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Limitation of Liability

The information in this manual is subject to change without notice and does not 
represent a commitment on the part of Sierra Wireless. SIERRA WIRELESS AND ITS 
AFFILIATES SPECIFICALLY DISCLAIM LIABILITY FOR ANY AND ALL DIRECT, INDIRECT, 
SPECIAL, GENERAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY 
DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS OR REVENUE OR 
ANTICIPATED PROFITS OR REVENUE ARISING OUT OF THE USE OR INABILITY TO USE 
ANY SIERRA WIRELESS PRODUCT, EVEN IF SIERRA WIRELESS AND/OR ITS AFFILIATES 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR THEY ARE 
FORESEEABLE OR FOR CLAIMS BY ANY THIRD PARTY.

Notwithstanding the foregoing, in no event shall Sierra Wireless and/or its 
affiliates aggregate liability arising under or in connection with the Sierra Wireless 
product, regardless of the number of events, occurrences, or claims giving rise to 
liability, be in excess of the price paid by the purchaser for the Sierra Wireless 
product.

Additional Information and Updates

For up-to-date product descriptions, documentation, application notes, firmware 
upgrades, troubleshooting tips, and press releases, visit:

www.sierrawireless.com

http://www.sierrawireless.com
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Sec tion 6A

Safety and Notices

In This Section

� Important Notice

� Safety and Hazards

This section describes important guidelines regarding your Sprint Mobile 
Broadband USB modem.
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Important Notice

Because of the nature of wireless communications, transmission and reception of 
data can never be guaranteed. Data may be delayed, corrupted (i.e., have errors) or 
be totally lost. Although significant delays or losses of data are rare when wireless 
devices such as the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) CDMA modem are used in a normal manner with a well-
constructed network, they should not be used in situations where failure to 
transmit or receive data could result in damage of any kind to the user or any 
other party, including but not limited to personal injury, death, or loss of property. 
SPRINT SPECTRUM L.P. accepts no responsibility for damages of any kind resulting 
from delays or errors in data transmitted or received using the Sprint Mobile 
Broadband USB modem by Sierra Wireless (AirCard 595U) CDMA modem, or for 
failure of the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) to transmit or receive such data.

Safety and Hazards

Do not operate the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) in areas where blasting is in progress, where explosive 
atmospheres may be present, near medical equipment, life support equipment, or 
any equipment which may be susceptible to any form of radio interference. In 
such areas, the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) MUST BE POWERED OFF. It can transmit signals that could interfere 
with this equipment.

Do not operate the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) in any aircraft, whether the aircraft is on the ground or in flight. In 
aircraft, the Sprint Mobile Broadband USB modem by Sierra Wireless 
(AirCard 595U) MUST BE POWERED OFF. When operating, it can transmit signals 
that could interfere with various onboard systems.

The driver or operator of any vehicle should not operate the Sprint Mobile 
Broadband USB modem by Sierra Wireless (AirCard 595U) while in control of a 
vehicle. Doing so will detract from the driver or operator's control and operation of 
that vehicle. In some jurisdictions, operating such communications devices while 
in control of a vehicle is an offense.

To avoid the risk of explosion, use the same battery model when replacing the 
battery. Properly dispose of the used battery.
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Section 6B

Terms and Conditions

In This Section

� Subscriber Agreement/General Terms and Conditions of Services

This section contains the terms and conditions of service for your Sprint Mobile 
Broadband USB modem.
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Subscriber Agreement
General Terms and Conditions of Services

Please note these terms may not be the most current version. A current version of 
the terms is available at our Web site or upon request.

Para solicitar esta literatura en español, por favor visitar a www.sprint.com.

Basic Definitions

In this document: (1) “we,” “us,” “our” mean Sprint Solutions, Inc. and its affiliates 
doing business as Sprint or Sprint PCS; (2) “you,” “your,” “customer,” and “user” 
mean an account holder or user with us; (3) “Device” means any phone, device, 
accessory or other product we sell to you or that is active on your account with us; 
and (4) “Service” means our offers, rate plans, options, wireless services or Devices 
on your account with us.

The Subscriber Agreement

The Subscriber Agreement (“Agreement”) is a contract under which we provide 
and you accept our Services. In addition to these Terms and Conditions of Service 
(“Ts&Cs”), there are several parts to the Agreement, including, but not limited to, 
the detailed plan or other information on Services we provide or refer you to 
during the sales transaction, and any confirmation materials we may provide you. 
It is important that you carefully read all of the terms of the Agreement.

Services Covered By These Ts&Cs & Additional Terms

These Ts&Cs apply to our standard wireless Services and any other Service we 
offer you that references these Ts&Cs. Different terms will apply to most business 
accounts. Additional terms will apply when you use certain Services, typically 
those you can access online (for example, picture/video Services, online forums, 
etc.). Additional terms will also apply if you activate Services as part of a bundle 
with another company’s services (for example, cable services, home phone 
services, etc.). The additional terms for bundled Services may either modify or 
replace certain provisions in these Ts&Cs, including terms relating to activation, 
invoicing/payment, and disputing charges. Also, a different dispute resolution 
provision may apply to services provided by another company (the dispute 
resolution provisions in this Agreement still apply to our Services). You will be 
provided details on any additional terms with your selection of any bundled 
Service.

http://www.sprint.com
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Our Policies

Services are subject to our business policies, practices and procedures (“Policies”), 
including, but not limited to, our Privacy Policy and Acceptable Use Policy and 
Visitor Agreement – both available at our Web site. You agree to all of our Policies 
when you use our Services. Our Policies are subject to change at anytime with or 
without notice.

When You Accept The Agreement

You must have the legal capacity to accept the Agreement. You accept the 
Agreement when you do any of the following: (a) sign a contract with us on paper 
or electronically; (b) accept Agreement through an oral or electronic statement; (c) 
attempt to or in any way use the Services; (d) pay for the Services; or (e) open any 
package or start any program that says you are accepting the Agreement when 
doing so. If you don’t want to accept the Agreement, don’t do any of these things.

Term Commitments & Early Termination Fees

Many of the Services (for example, rate plans and Device discounts) that we offer 
require you to maintain certain Services with us for a minimum term, usually 1 or 
2 years (“Term Commitment”). You will be charged a fee (“Early Termination Fee”) for 
each line of Service that you terminate early (i.e., prior to satisfying the Term 
Commitment) or for each line of Service that we terminate early for good reason (for 
example, violating the payment or other terms of the Agreement). Early Termination 
Fees are a part of our rates. Your exact Term Commitment and Early Termination 
Fee may vary based on the Services you select and will be disclosed to you during 
the sales transaction. Carefully review any Term Commitment and Early Termination 
Fee requirements prior to selecting Services. After you have satisfied your Term 
Commitment, your Services continue on a month-to-month basis without any 
Early Termination Fee, unless you agree to extend your Term Commitment or 
agree to a new Term Commitment – for example, by accepting a new rate plan or 
upgrading your Device. As explained directly below, there are instances when you 
will not be responsible for an Early Termination Fee for terminating Services early.

When You Don’t Have To Pay An Early Termination Fee

You aren’t responsible for paying an Early Termination Fee when terminating 
Services: (a) provided on a month-to-month basis; (b) consistent with our 
published trial period return policy; or (c) in response to a materially adverse 
change we make to the Agreement as described directly below.
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Our Right To Change The Agreement & Your Related Rights

We may change any part of the Agreement at any time, including, but not limited to, 
rates, charges, how we calculate charges, or your terms of Service. We will provide you 
notice of material changes, and may provide you notice of non-material changes, in a 
manner consistent with this Agreement (see “Providing Notice Under This Agreement” 
paragraph). Except as provided below, if a change we make to the Agreement is 
material and has a material adverse effect on you, you may terminate each line of 
Service materially affected without incurring an Early Termination Fee only if you: 
(a) call us within 30 days after the effective date of the change; and (b) specifically 
advise us that you wish to cancel Services because of a material change to the 
Agreement that we have made. If you do not cancel Service within 30 days of the 
change, an Early Termination Fee will apply if you terminate Services before the 
end of any applicable Term Commitment.

Our Right To Suspend Or Terminate Services

We can, without notice, suspend or terminate any Service at any time for any reason, 
including, but not limited to: (a) late payment; (b) exceeding an Account Spending 
Limit (“ASL”); (c) harassing/threatening our employees or agents; (d) providing 
false information; (e) interfering with our operations; (f) using/suspicion of using 
Services in any manner restricted by or inconsistent with the Agreement; 
(g) breaching the Agreement, including our Policies; (h) providing false, 
inaccurate, dated or unverifiable identification or credit information, or becoming 
insolvent or bankrupt; (i) modifying a Device from its manufacturer 
specifications; or ( j) if we believe the action protects our interests, any customer’s 
interests or our network.

Your Ability To Change Services & When Changes Are Effective

You typically can change Services upon request. In some instances, changes may 
be conditioned on payment of an Early Termination Fee or certain other charges, 
or they may require you to accept a new Term Commitment. Changes to Services 
are usually effective at the start of your next full invoicing cycle. If the changes 
take place sooner, your invoice may reflect pro-rated charges for your old and 
new Services.

Your Right To Terminate Services

You can terminate Services at any time by calling us and requesting that we 
deactivate all Services. You’re responsible for all charges billed or incurred prior to 
deactivation. If Services are terminated before the end of your invoicing cycle, we 
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won’t prorate charges to the date of termination and you won’t receive a credit or 
refund for any unused Services. Except as provided above, you must also pay us an 
Early Termination Fee for each line of Service that you terminate early.

Credit Checks & Credit Information

We agree to provide you Services on the condition you have and maintain 
satisfactory credit according to our standards and policies. You agree to provide 
information we may request or complete any applications we may provide you to 
facilitate our review. We rely on the credit information you furnish, credit bureau 
reports or other data available from commercial credit reference services, and 
other information (such as payment history with us) to determine whether to 
provide or continue to provide you Services. The Services we offer you can vary 
based on your credit history. We may at any time, based on your credit history, 
withdraw or change Services, or place limits or conditions on the use of our 
Services. You agree to provide us updated credit information upon request. 
We may provide your payment history and other account billing/charge 
information to any credit reporting agency or industry clearinghouse.

Account Spending Limits (“ASL”)

An ASL is a temporary or permanent limit (typically based on credit history, 
payment history, or to prevent fraud) we place on the amount of unpaid charges 
you can accumulate on your account, regardless of when payment on those 
charges is due. We reserve the right to determine which charges count towards an 
ASL. If you have an ASL, we may suspend your Services without prior notice if your 
account balance reaches the ASL, even if your account is not past due. We may 
impose or increase an ASL at any time with notice. An ASL is for our benefit only 
and should not be relied on by you to manage usage.

Deposits & Returning Deposits

We may at any time require a deposit, as a guarantee of payment, for you to 
establish or maintain Service (“Deposit”). By providing us a Deposit, you grant us a 
security interest for all current or future amounts owed to us. We may change the 
Deposit at any time with notice. You can’t use a Deposit to make or delay 
payments. The Deposit, the length of time we hold the Deposit, and changes to 
the Deposit are determined based on your credit history, payment history and 
other factors. Unless prohibited by law, we may mix Deposits with our other funds 
and it won’t earn interest and we reserve the right to return the Deposit as a 
credit on your invoice at anytime. If your Services are terminated for any reason, 
we may keep and apply your Deposit to any outstanding charges. We’ll send any 
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remaining portion of Deposit to your last known address within 90 days after your 
final invoice – if it is returned to us, we will forward it on to the appropriate state 
authorities to the extent required by law.

Restrictions On Using Services

You can’t use our Services: (a) to transmit content/messages that are, or in any 
manner that is, illegal, fraudulent, threatening, abusive, defamatory, or obscene; 
(b) in a way that could cause damage or adversely affect our customers, 
reputation, network, property or Services; (c) to communicate any unsolicited 
commercial voice, text, SMS, or other message; (d) to infringe on the copyright of 
another, or upload or transmit any “virus”, “worm”, or malicious code; or (e) in any 
way prohibited by the terms of our Services, the Agreement or our Policies.

Your Device, Number & E-mail Address; Caller ID

We don’t manufacture any Device we might sell to you or that is associated with 
our Services, and we aren’t responsible for any defects, acts or omissions of the 
manufacturer. The only warranties on your Device are the limited warranties given to 
you by the manufacturer directly or that we pass through. Your Device is designed 
exclusively for use on our network and in other coverage areas we make available 
to you. It will not accept wireless service from another carrier. Except for any legal 
right you may have to port/transfer your phone number to another carrier, you 
have no and cannot gain any (for example, through publication, use, etc.) 
proprietary, ownership or other rights to any phone number, identification 
number, e-mail address or other identifier we assign to you, your Device or your 
account. We’ll notify you if we decide to change or reassign them.

Porting/Transferring Phone Numbers

We don’t guarantee that number transfers to or from us will be successful. If you 
authorize another carrier to transfer a number away from us, that is considered a 
request by you to us to terminate all of the Services associated with that number. 
You’re responsible for all charges billed or incurred prior to deactivation and for 
any applicable Early Termination Fees.

Coverage; Where Your Device Will Work

Our coverage maps are available at our stores and at our Web site. The specific 
network coverage you get will depend on the radio transmissions your Device can 
pick up and Services you’ve chosen. Our coverage maps provide high level estimates 
of our coverage areas when using Services outdoors under optimal conditions. 
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Coverage isn’t available everywhere. Estimating wireless coverage and signal strength 
is not an exact science. There are gaps in coverage within our estimated coverage areas 
that, along with other factors both within and beyond our control (network problems, 
software, signal strength, your Device, structures, buildings, weather, geography, 
topography, etc.), may result in dropped and blocked connections, slower data speeds, 
or otherwise impact the quality of Service. Services that rely on location information, 
such as E911 and GPS navigation, depend on your Device’s ability to acquire satellite 
signals (typically not available indoors) and network coverage.

Roaming

“Roaming” typically refers to coverage on another carrier’s network that we make 
available to you based on our agreements with other carriers. These agreements 
may change from time to time and roaming coverage is subject to change. Your 
ability to receive roaming coverage depends on the radio transmissions your 
Device can pick up. You can pick up roaming coverage both within and outside our 
network coverage areas. Your Device will generally indicate when you’re roaming. 
Depending on your Services, separate charges or limits on the amount of minutes 
used while roaming may apply. Certain Services may not be available or work the 
same when roaming (including data Services, voicemail, call waiting, etc.).

About Data Services & Content

Our data Services and your Device may allow you to access the internet, text, 
pictures, video, games, graphics, music, email, sound and other materials (“Data 
Content”) or send Data Content elsewhere. Some Data Content is available from 
us or our vendors, while other Data Content can be accessed from others (third 
party Web sites, games, ringers, etc.). We make absolutely no guarantees about 
the Data Content you access on your Device. Data Content may be: (1) unsuitable for 
children/minors; (2) unreliable or inaccurate; or (3) offensive, indecent or objectionable. 
You’re solely responsible for evaluating the Data Content accessed by you or anyone on 
your account. We strongly recommend you monitor data usage by children/minors. 
Data Content from third parties may also harm your Device or its software. To 
protect our network, Services, or for other reasons, we may place restrictions on 
accessing certain Data Content (such as certain Web sites, applications, etc.), 
impose separate charges, limit throughput or the amount of data you can 
transfer, or otherwise limit or terminate Services. If we provide you storage for 
Data Content you have purchased, we may delete the Data Content with notice or 
place restrictions/limits on the use of storage areas. You may not be able to make 
or receive voice calls while using data Services.
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Specific Terms & Restrictions On Using Data Services

In addition to the rules for using all of our other Services, unless we identify the 
Service or Device you have selected as specifically intended for that purpose (for 
example, wireless routers, Data Link, etc.), you can’t use our data Services: (1) with 
server devices or host computer applications, or other systems that drive 
continuous heavy traffic or data sessions; and (2) as a substitute or backup for 
private lines or frame relay connections. We reserve the right to limit or suspend 
any heavy, continuous data usage that adversely impacts our network 
performance or hinders access to our network. If your Services include unlimited 
Web or data access, you also can’t use your Device as a modem for computers or 
other equipment, unless we identify the Service or Device you have selected as 
specifically intended for that purpose (for example, with “phone as modem” 
plans, Sprint Mobile Broadband card plans, wireless router plans, etc.).

Activation & Miscellaneous Charges

Based on our Policies, we may charge activation, prepayment, reactivation, 
program or other fees to establish or maintain Services. Certain transactions may 
also be subject to a charge (for example, convenience payment, changing phone 
numbers, handset upgrades, etc.). You will be provided notice of these types of 
fees before we complete the requested transaction.

Account & Service Charges; Pro-rating; Unused Minutes

You are responsible for all charges associated with your account and the Services on 
your account, no matter who uses the Services. Charges include, but are not limited 
to, the monthly recurring charges, usage charges, taxes, surcharges and fees 
associated with your Services. These charges are described or referred to during 
the sales transaction, in our marketing materials, and in confirmation materials 
we may send to you.

How We Calculate Your Charges For Billing Purposes

Regular Voice Calls: We round up partial minutes of use to the next full minute. 
Time starts when you press “Talk” or your Device connects to the network and 
stops when you press “End” or the network connection otherwise breaks. You’re 
charged for all calls that connect, even to answering machines. You won’t be 
charged for unanswered calls or if you get a busy signal. For incoming calls 
answered, you’re charged from the time shortly before the Device starts ringing 
until you press “End” or the network connection otherwise breaks. If charges vary 
depending on the time of day that you place or receive calls (e.g., Nights and 
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Weekend plans), you’re charged for the entire call based on the rate that applies 
to the time period in which the call starts.

iDEN Walkie-Talkie Charges: Charges for walkie-talkie calls are billed to the person 
who starts the call and calculated by multiplying the duration of the call by the 
applicable rate and number of participants. You’re charged at least 6 seconds of 
airtime for each call you start; subsequent communications in the same call are 
rounded up to and billed to the next second. Time begins when you press any 
button to start a walkie-talkie call and ends approximately 6 seconds after 
completion of a communication to which no participant responds – subsequent 
walkie-talkie communications are considered new calls. Depending on your plan, 
nationwide, international or group walkie-talkie calls may use the local walkie-
talkie minutes in your plan and result in additional charges. Responses to call alert 
transmissions are treated as new walkie-talkie transmissions even when 
responding within 6 seconds of receiving the alert.

Data Usage: Unless we specifically tell you otherwise, data usage is measured in 
bytes, kilobytes and megabytes – not in minutes/time. 1024 bytes equals 
1 kilobyte (“KB”), and 1024 KB equals 1 megabyte. Bytes are rounded up to 
kilobytes, so you will be charged at least 1 KB for each data usage session (“data 
session”). Rounding occurs at the end of each data session, and sometimes during 
a data session. Depending on your data Services, usage may be charged against an 
allowance or on a fixed price per KB. If you are charged on a fixed price per KB, any 
fractional cents will be rounded up to the next cent. You are charged for all data 
directed to your Device’s internet address, including data sessions you did not 
initiate and for incomplete transfers. As long as your Device is connected to our 
data network, you may incur data charges. Examples of data you will be charged 
for includes the size of a requested file or Data Content (game, ringer, etc.), Web 
page graphics (logos, pictures, banners, advertisement, etc.), additional data used 
in accessing, transporting and routing the file on our network, data from partial or 
interrupted downloads, re-sent data, and data associated with unsuccessful 
attempts to reach Web sites or use applications. These data charges are in 
addition to any charges for the Data Content itself (game, ringer, etc.). Data used 
and charged to you will vary widely, even between identical actions or data 
sessions. Estimates of data usage – for example, the size of downloadable files – 
are not reliable predictors of actual usage. Your bill won’t separately list the 
number of KB attributed to a specific action/data session.
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Your Bill

Your bill provides you notice of your charges. It reflects monthly recurring charges 
(usually billed one bill cycle in advance) and usage/transaction specific charges 
(usually billed in the bill cycle in which they’re incurred). Some usage charges, 
such as those that depend on usage information from a third party, may be billed 
in subsequent bill cycles and result in higher than expected charges for that 
month. Bill cycles and dates may change from time to time. Your bill may also 
include other important notices (for example, changes to this Agreement, to your 
Service, legal notices, etc.). Your paper bill may not include individual call detail. 
Your call detail is available online. Paper bills with call detail may be subject to an 
additional charge. If you choose internet billing, you will not receive paper bills.

Your Payments; Late Fees

Payment is due in full as stated on your bill. If we do not receive payment in full by 
the date specified on your bill, a late payment charge, which may be charged at 
the highest rate permissible by law, may be applied to the total unpaid balance. 
We may also charge you any costs we pay to a collection agency to collect unpaid 
balances from you. If we bill you for amounts on behalf of a third party, payments 
received are first applied to our charges. You may be charged additional fees for 
certain methods of payment. We may charge you, up to the highest amount 
permitted by law, for returned checks or other payments paid by you and denied 
for any reason by a financial institution. Acceptance of payments (even if marked 
“paid in full”) does not waive our right to collect all amounts that you owe us. We 
may restrict your payment methods to cashier’s check, money order, or other 
similar secure form of payment at any time for good reason.

Taxes & Government Fees

You agree to pay all federal, state and local taxes, fees and other assessments that 
we’re required by law to collect on the Services we provide you and remit to the 
government. These charges may change from time to time without advance 
notice. If you’re claiming any tax exemption, you must provide us with a valid 
exemption certificate. Tax exemptions generally won’t be applied retroactively.

Surcharges

You agree to pay the surcharges, fees and other charges that we assess to recoup 
our government costs or costs of complying with certain government programs 
(“Surcharges”). Surcharges aren’t taxes or government mandated charges; they’re 
charges we choose to collect from you. Surcharges are subject to change, sometimes on 
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a monthly or quarterly basis. Examples of Surcharges include, but are not limited to: 
Universal Service Fund, E911, Federal Programs Cost Recovery, Federal Wireless 
Number Pooling and Portability, and gross receipts charges. We will make efforts 
to provide you notice of any changes to Surcharges in a manner consistent with 
this Agreement (see “Providing Notice Under This Agreement” paragraph). 
However, since most Surcharges are based on amounts set by the government or 
based on government formulas, it will not always be possible to provide advance 
notice of new Surcharges or changes in the amount of existing Surcharges. 
Information on Surcharges is provided during the sales transaction and is 
available at our Web site.

Disputing Charges - You Must Still Pay Undisputed Charges

Any dispute to a charge on your bill must be made within 60 days of the date of 
the bill that initially contained the charge. Disputes can only be made by calling or 
writing us as directed on your invoice or elsewhere. You accept all charges not 
properly disputed within the above time period – undisputed charges must still be 
paid as stated on your bill.

Protecting Our Network & Services

We can take any action to: (1) protect our network, our rights and interests, or the 
rights of others; or (2) optimize or improve the overall use of our network and 
Services. Some of these actions may interrupt or prevent legitimate 
communications and usage – for example, message filtering/blocking software to 
prevent SPAM or viruses, limiting throughput, limiting access to certain Web sites, 
applications or other Data Content, etc. For additional information on what we do 
to protect our customers, network, Services and equipment, see our Acceptable 
Use Policy and Visitor Agreement at our Web site.

Your Privacy

You agree to the terms of our Privacy Policy, available at our Web site, when you 
use our Services. This policy may change from time to time, so review this policy 
with regularity and care. Among other things, the policy includes important 
information on what information we collect about you, how we use that 
information, and with whom we share that information (for example, to provide 
you certain Services, to protect our rights and interests, to respond to legal 
process, to facilitate a merger, etc.). Also, to ensure the quality of our Services and 
for other lawful purposes, we may also monitor or record calls between us (for 
example, your conversations with our customer service or sales departments). 
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If you do not agree with the terms of our Privacy Policy, do not purchase or use 
our Services.

Location Based Services

Our network generally knows the location of your Device when it is outdoors and 
turned on. By using various technologies to locate your Device, we can provide 
enhanced emergency 911 services, and optional location-sensitive services 
provided by us or a third party. Environmental factors (such as structures, 
buildings, weather, geography, landscape, and topography) can significantly 
impact the ability to access your Device’s location information and use of 
location-sensitive services. The terms and conditions of any location-sensitive 
service that you purchase from us may provide more information about how 
location information is used and disclosed. Use of some of location-sensitive 
services may require network coverage. If any Device on your account uses a 
location-sensitive service, you (the accountholder) must clearly and regularly notify the 
actual user of your Device that their location may be tracked or discovered. For 
additional information on location-sensitive services, see our Privacy Policy at our 
Web site.

911 Or Other Emergency Calls

Public Safety Officials advise that when making 911 or other emergency calls, you 
should always be prepared to provide your location information. Unlike traditional 
wireline phones, depending on a number of factors (e.g., whether your Device is 
GPS enabled, where you are, whether local emergency service providers have 
upgraded their equipment, etc.), 911 operators may not know your phone 
number, your location or the location of your Device. In certain circumstances, an 
emergency call may be routed to a state patrol dispatcher or alternative location 
set by local emergency service providers. Enhanced 911 service (“E911”), where 
enabled by local emergency authorities, uses GPS technology to provide location 
information. Even when available, however, E911 does not always provide 
accurate location information. If your Device is indoors or for some other reason 
cannot acquire a satellite signal, you may not be located. Some Devices have a 
safety feature that prevents use of the keypad after dialing 911 – you should 
follow voice prompts when interacting with emergency service providers 
employing IVR systems to screen calls.

If Your Device Is Lost or Stolen

Call us immediately if your Device is lost or stolen because you may be responsible 
for usage charges before you notify us of the alleged loss or theft. You agree to 
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cooperate if we choose to investigate the matter (provide facts, sworn 
statements, etc.). We may not waive any Early Termination Fees if you choose to 
terminate Services as a result of loss or theft of your Device.

Disclaimer of Warranties

WE MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING (TO THE EXTENT ALLOWED BY LAW) ANY IMPLIED WARRANTY OF 
MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR 
PURPOSE CONCERNING YOUR SERVICES (INCLUDING YOUR DEVICE). WE DON’T 
PROMISE UNINTERRUPTED OR ERROR-FREE SERVICES AND DON’T AUTHORIZE 
ANYONE TO MAKE WARRANTIES ON OUR BEHALF.

You Agree We Are Not Responsible For Certain Problems

You agree that neither we nor our vendors, suppliers or licensors are responsible 
for any damages resulting from: (a) anything done or not done by someone else; 
(b) providing or failing to provide Services, including, but not limited to, 
deficiencies or problems with a Device or network coverage (for example, 
dropped, blocked, interrupted calls/messages, etc.); (c) traffic or other accidents, 
or any health-related claims relating to our Services; (d) Data Content or 
information accessed while using our Services; (e) an interruption or failure in 
accessing or attempting to access emergency services from a Device, including 
through 911, Enhanced 911 or otherwise; (f) interrupted, failed, or inaccurate 
location information services, (g) information or communication that is blocked 
by a spam filter, or (h) things beyond our control, including acts of God (for 
example, weather-related phenomena, fire, earthquake, hurricane, etc.), riot, 
strike, war, terrorism or government orders or acts.

You Agree Our Liability Is Limited - No Consequential Damages.

TO THE EXTENT ALLOWED BY LAW, OUR LIABILITY FOR MONETARY DAMAGES FOR 
ANY CLAIMS YOU MAY HAVE AGAINST US IS LIMITED TO NO MORE THAN THE 
PROPORTIONATE AMOUNT OF THE SERVICE CHARGES ATTRIBUTABLE TO THE 
AFFECTED PERIOD. UNDER NO CIRCUMSTANCES ARE WE LIABLE FOR ANY 
INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR SPECIAL DAMAGES OF ANY NATURE 
WHATSOEVER ARISING OUT OF OR RELATED TO PROVIDING OR FAILING TO 
PROVIDE SERVICES IN CONNECTION WITH A DEVICE, INCLUDING, BUT NOT 
LIMITED TO, LOST PROFITS, LOSS OF BUSINESS, OR COST OF REPLACEMENT 
PRODUCTS AND SERVICES.
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DISPUTE RESOLUTION
We Agree To First Contact Each Other With Any Disputes

We each agree to first contact each other with any disputes and provide a written 
description of the problem, all relevant documents/information and the proposed 
resolution. You agree to contact us with disputes by calling or writing us as 
instructed on your invoice. We will contact you by letter to your billing address or 
on your Device.

Instead Of Suing In Court, We Each Agree To Arbitrate Disputes

We each agree to finally settle all disputes (as defined and subject to any specific 
exceptions below) only by arbitration. In arbitration, there’s no judge or jury and 
review is limited. However, just as a court would, the arbitrator must honor the 
terms and limitations in the Agreement and can award the same damages and 
relief, including any attorney’s fees authorized by law. The arbitrator’s decision 
and award is final and binding, with some exceptions under the Federal 
Arbitration Act (“FAA”), and judgment on the award may be entered in any court 
with jurisdiction. We each also agree as follows:

(1) “Disputes” are any claims or controversies against each other related in any way to 
our Services or the Agreement, including, but not limited to, coverage, Devices, privacy, 
or advertising, even if it arises after Services have terminated – this includes claims 
you bring against our employees, agents, affiliates or other representatives, or 
that we bring against you.

(2) If either of us wants to arbitrate a dispute, we agree to send written notice to 
the other providing a description of the dispute, previous efforts to resolve the 
dispute, all supporting documents/information, and the proposed resolution. 
Notice to you will be sent to your billing address and notice to us will be sent to: 
General Counsel; Arbitration Office; 2001 Edmund Halley Drive VARESP0513-502; 
Reston, Virginia 20191. We agree to make attempts to resolve the dispute. If we 
cannot resolve the dispute within forty-five (45) days of receipt of the notice to 
arbitrate, then we may submit the dispute to formal arbitration.

(3) The FAA applies to this Agreement and arbitration provision. We each agree 
the FAA’s provisions, not state law, govern all questions of whether a dispute is 
subject to arbitration.

(4) The arbitration will be administered by the National Arbitration Forum (“NAF”) 
under its arbitration rules. If any NAF rule conflicts with the terms of the 
Agreement, the terms of the Agreement apply. You can obtain procedures, rules, 
and fee information from the NAF at 1-800-474-2371 or www.adrforum.com.

http://www.adrforum.com
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(5) Unless we each agree otherwise, the Arbitration will be conducted by a single 
neutral arbitrator and will take place in the county of your last billing address. The 
federal or state law that applies to the Agreement will also apply during the 
arbitration.

(6) We each agree not to pursue arbitration on a classwide basis. We each agree that 
any arbitration will be solely between you and us (not brought on behalf of or together 
with another individual’s claim). If for any reason any court or arbitrator holds that this 
restriction is unconscionable or unenforceable, then our agreement to arbitrate doesn’t 
apply and the dispute must be brought in court.

(7) We each are responsible for our respective costs relating to counsel, experts, 
and witnesses, as well as any other costs relating to the arbitration. However, we 
will cover any arbitration administrative or filing fees above: (a) $25 if you are 
seeking less than $1,000 from us; or (b) the equivalent court filing fees for a court 
action in the appropriate jurisdiction if you are seeking $1,000 or more from us.

Exceptions To Our Agreement To Arbitrate Disputes

Either of us may bring qualifying claims in small claims court. In addition, this 
arbitration provision does not prevent you from filing your dispute with any 
federal, state or local government agency that can, if the law allows, seek relief 
against us on your behalf.
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No Class Actions

TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO PURSUE 
DISPUTES ON A CLASSWIDE BASIS; THAT IS, TO EITHER JOIN A CLAIM WITH THE 
CLAIM OF ANY OTHER PERSON OR ENTITY, OR ASSERT A CLAIM IN A 
REPRESENTATIVE CAPACITY ON BEHALF OF ANYONE ELSE IN ANY LAWSUIT, 
ARBITRATION OR OTHER PROCEEDING.

No Trial By Jury

TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO TRIAL BY JURY 
IN ANY LAWSUIT, ARBITRATION OR OTHER PROCEEDING.

Indemnification

You agree to indemnify, defend and hold us harmless from any claims arising out 
of your actions, including, but not limited to, failing to provide appropriate notices 
regarding location-sensitive services (see “Location Based Services” paragraph), or 
violating this Agreement, any applicable law or regulation or the rights of any 
third party.

Providing Notice To Each Other Under The Agreement

Except as the Agreement specifically provides otherwise, you must provide us 
notice by calling or writing us as instructed on your invoice. We will provide you 
notice in your bill, correspondence to your last known billing address, to any fax 
number or e-mail address you’ve provided us, by calling you on your home phone 
or Device, by voice message on your Device or home phone, or by text message on 
your Device.

Other Important Terms

Subject to federal law or unless the Agreement specifically provides otherwise, 
this Agreement is governed solely by the laws of the state encompassing the area 
code assigned to your Device, without regard to the conflicts of law rules of that 
state. If either of us waives or doesn’t enforce a requirement under this 
Agreement in an instance, we don’t waive our right to later enforce that 
requirement. Except as the Agreement specifically provides otherwise, if any part 
of the Agreement is held invalid or unenforceable, the rest of this Agreement 
remains in full force and effect. This Agreement isn’t for the benefit of any 3rd 
party except our corporate parents, affiliates, subsidiaries, agents, and 
predecessors and successors in interest. You can’t assign the Agreement or any of 
your rights or duties under it. We can assign the Agreement. The Agreement and 



Section 6B: Terms and Conditions      151

the documents it incorporates make up the entire agreement between us and 
replaces all prior written or spoken agreements – you can’t rely on any 
contradictory documents or statements by sales or service representatives. The 
rights, obligations and commitments in the Agreement that, by their nature, 
would logically continue beyond the termination of Services (including, but not 
limited to, those relating to billing, payment, 911, dispute resolution, no class 
action, no jury trial), survive termination of Services.

© 2007 Sprint Nextel. All rights reserved. No reproduction in whole or in part 
without prior written approval. SPRINT and other trademarks are trademarks of 
Sprint Nextel. iDEN is a trademark of Motorola, Inc.
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Glossary

1X
One Times Radio Transmission Technology (the “one times” refers to the frequency 
spectrum). Also known as Sprint Vision. Supports Internet connections with data 
rates up to 153 kbps. Actual speed depends on the network conditions. Compare 
to 1xEV-DO.

1xEV-DO
A high-speed standard for cellular packet data communications. Also known as 
Sprint Power Vision.

1xEV-DO Rev. A supports Internet connections with data rates up to 3.1 Mbps 
(downlink from the network) and 1.8 Mbps (uplink to the network). Average data 
rates are 600 kbps - 1.4 Mbps (downlink from the network) and 350-500 kbps 
(uplink to the network).

1xEV-DO Rev. 0 supports Internet connections with data rates up to 2.4 Mbps 
(downlink from the network) and 153 kbps (uplink to the network). Average data 
rates are 400-700 kbps (downlink from the network) and 40-80 kbps (uplink to the 
network)

Actual speed depends on the network conditions. Compare to 1X.

bps
bits per second—The actual data speed over the transmission medium.

broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

CDMA
Code Division Multiple Access—A wideband spread spectrum technique used in 
digital cellular, personal communications services, and other wireless networks. 
Wide channels (1.25 MHz) are obtained through spread spectrum transmissions, 
thus allowing many active users to share the same channel. Each user is assigned 
a unique digital code, which differentiates the individual conversations on the 
same channel.

dBm
decibels relative to 1 milliwatt
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dormant
The network switches the data connection into dormant mode if there is no traffic 
on the connection for some time. When you resume data traffic, the high-speed 
data connection becomes active.

The data connection may also go dormant while a GPS fix is being acquired.

ESN
Electronic Serial Number—The unique serial number assigned to the USB modem 
for cellular network use. Either the ESN or MEID is on the label on the USB modem 
(under the battery), and is also displayed in the Device Info & Diagnostics window 
(page 77). See also MEID.

FCC
Federal Communications Commission—The U.S. federal agency that is responsible 
for interstate and foreign communications. The FCC regulates commercial and 
private radio spectrum management, sets rates for communications services, 
determines standards for equipment, and controls broadcast licensing. Consult 
www.fcc.gov.

fix
GPS location information obtained from the network.

GPS
Global Positioning System—A system that uses a series of 24 geosynchronous 
satellites to provide location data.

HEPE
Horizontal Estimated Position Error—Relates to GPS accuracy.

IS
Interim Standard—After receiving industry consensus, the TIA forwards the 
standard to ANSI for approval.

kbps
kilobits per second—Actually 1000, not 1024, as used in computer memory size 
measurements of kilobytes.

LAN
Local Area Network

http://www.fcc.gov
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LED
Light Emitting Diode—A semiconductor diode that emits visible or infrared light.

Mbps
Megabits per second

MEID
Mobile Equipment Identifier—The unique second-generation serial number 
assigned to the Sprint Mobile Broadband USB modem for cellular network use. 
Either the MEID or ESN is on the label on the USB modem (under the battery), and 
is also displayed in the Device Info & Diagnostics window (page 77). Compare to 
ESN.

MHz
megahertz—One million cycles per second

PCS
Personal Communications Services—A cellular communication infrastructure.

roaming
A wireless subscriber is in an area where service is obtained from a wireless service 
provider other than Sprint. This may be subject to roaming charges. 
Sprint Location Services may not be available.

Sprint Connection Manager
Software that allows you to manage the Sprint Mobile Broadband USB modem’s 
actions and monitor your connections on a Windows computer.

Sprint Mobile Broadband
High-speed wireless services optimized for data. Sprint Mobile Broadband is the 
next evolutionary step for the Sprint Power Vision Network.

Sprint Power Vision
Sprint’s advanced multimedia third generation services available on the network. 
See 1xEV-DO.

Sprint Vision
Sprint’s advanced multimedia third generation services available on the network. 
See 1X.
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system tray
Usually located in the bottom right of the screen (near the clock). When 

Sprint Connection Manager is running, it places an icon  in this area, which you 
can use to monitor the connection state (page 42). If you right-click the icon, a 
shortcut menu is displayed (page 63):

TIA
Telecommunications Industry Association—A standards-setting trade organization, 
whose members provide communications and information technology products, 
systems, distribution services, and professional services in the United States and 
around the world. Consult www.tiaonline.org.

ToolTip
Text that displays when you position the mouse pointer over an area of the screen 
(for example, over an indicator).

VPN
Virtual Private Network

WAN
Wide Area Network

Watcher Lite
Software that allows you to manage the Sprint Mobile Broadband USB modem’s 
actions and monitor your connections on a Mac computer.

http://www.tiaonline.org
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Index
Symbols
$GPGGA, 90
$GPGSA, 90
$GPGSV, 90
$GPRMC, 90

Numerics
1-888-715-4588 (Sprint Customer Service), 

13
1-888-788-4727 (Sprint Customer Service), 

13
1X Only (Network Mode) (Windows), 70
1X, 1xEV-DO

description, 5
amount of data transferred (Mac), 111
amount of data transferred (Windows), 

53
application to automatically launch upon 

network connection (Windows), 52
automatically connecting when ready 

(Windows), 69
cannot connect (Mac), 114
cannot connect (Windows), 95
connecting (Mac), 110
connecting (Windows), 50
coverage, determining (Mac), 110
coverage, determining (Windows), 43
dormant indicator (Windows), 35
ending a connection (Mac), 110
ending a connection (Windows), 54
icons (Mac), 110
icons (Windows), 34
roaming indicator (Mac), 110
roaming indicator (Windows), 34
transmit/receive indicator (Windows), 35
warning when roaming (Windows), 51

1xEV-DO Only (Network Mode) (Windows), 
69

2000, Windows, 9
3G. See 1X, 1xEV-DO.

A
About Sprint Mobile Broadband, 80
accessibility, 122
accessories, 13
account

accessing, 13
charges, 142
setting up (Mac), 107

setting up (Windows), 24
Account Spending Limits (ASL), 139
accuracy, GPS (Windows only), 36
"Acquired" message (Windows only), 41
activating the USB modem

Mac, 107
Windows, 24

activation
Mac, 107
Windows, 24

Activation Assistant (Mac), 108
activation code

Mac, 109
Windows, 26

Activation Wizard (Windows)
overview, 24
Activation Wizard button, 70

Activation, One Touch, 5, 25
Advanced Forward Link Trilateration (AFLT) 

(Windows only), 88
AFLT (Advanced Forward Link Trilateration) 

(Windows only), 88
agreement, subscriber, 136
aircraft

hazards warning, 134
powering the USB modem off in 

(Windows only), 45
Alert Log (Windows), 76
alerts (Windows), 76
altitude (Windows only), 37
Always Ask (Roam Guard) (Windows), 52
always on

billing, 83
set (Windows), 33

Always on top (Windows), 67
Always show Welcome screens (Windows), 

69
Always-on connection, 51
amount of data transferred

Mac, 111
Windows, 53

antenna, adjusting
Mac, 106
Windows, 19

antenna, external, attaching
Mac, 111
Windows, 43

AOL, 84
application, GPS (Windows only)

configuring, 90
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definition, 89
approvals, 121
arbitration of disputes, 148
ASL (Account Spending Limits), 139
assistance

online Help (Windows only), 54
Sprint Customer Service, 13
Sprint Web site, 13

authentication, 122
auto-launch Sprint Connection Manager, 33
Auto-launch upon network connection 

(Windows), 52
Automatic (Network Mode) (Windows), 69
Automatic (roaming option) (Windows), 70
automatically connecting to network 

(Windows), 69
automatically starting Sprint Connection 

Manager, 33
AutoPreview, 84

B
battery

warning (Mac), 105
warning (Windows), 19
charging (Mac), 107
charging (Windows), 20
inserting into USB modem (Mac), 105
inserting into USB modem (Windows), 19
replacing, 6

behavior when the USB modem is locked 
(Windows), 56

bill, 144
billing, and always on, 83
blasting — hazards warning, 134
bookmarks (Windows), 58
business usage (Windows), 75

C
call duration

Mac, 110
Windows, 75

cannot connect to the network
Mac, 114
Windows, 95

care and maintenance, 6
caution, 125
CDMA

networks, 4
roaming - description, 4
signal strength indicator (Mac), 110

signal strength indicator (Windows), 34
specification, 122

changing the lock code (Windows), 58
channel spacing, 121
charges

disputing, 145
possible charges, 142

charging the battery
Mac, 107
Windows, 20

Check for updates once per month 
(Windows), 67

Check Now button (Windows), 67
Clear Log (Windows), 76
Close Sprint Connection Manager, 49
Close Sprint Mobile Broadband (Windows), 

49
compact view (Windows)

GPS Receiver window, 48
Mobile Broadband window, 47

conditions and terms of service, 135
Connect button (Mac)

unavailable, 113
usage, 110

"Connected" message (Windows), 39
connected icon (Windows), 42
"Connected to NDIS" message (Windows), 

40
"Connecting" message (Windows), 39
connecting icon (Windows), 42
connecting to the network (Mac), 110
connecting to the network (Windows)

automatically, 69
manually, 50

connection (Mac)
amount of data transferred, 111
cannot connect, 114
ending, 110
launching, 110
states, 110

connection (Windows)
1X or 1xEV-DO (Network Mode), 70
alert log, 76
Always-on, 51
amount of data transferred, 53
application to automatically launch upon 

network connection, 52
automatically connecting when ready, 69
cannot connect, 95
diagnostics, 77
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ending, 54
history, 75
issues, 76
launching, 50
Network Mode, 70
states (GPS Receiver window), 41
states (Mobile Broadband window), 38
states (system tray), 42
warning when roaming, 51

Connection History (Windows), 75
Connection Manager

Mac. See Watcher Lite.
Windows. See Sprint Connection 

Manager.
connection states (Mac), 110
connection states (Windows)

GPS Receiver window, 41
Mobile Broadband window, 38
system tray, 42

Consent Agreement (Windows), 72
content, data, 141
contents of package, 6
Control Plane, GPS (Windows only), 86
"Could not prepare data services" message 

(Windows), 97
coverage

disclaimer, 140
maps, 13
type, determining (Mac), 110
type, determining (Windows), 43

Create Report (Windows), 79
current direction (Windows only), 37
current speed (Windows only), 36
current, electrical, 121
customer support, 13

D
data content, 141
Data LED, 120
data profile (Windows), 27
data provisioning

Mac, 107
Windows, 27

data speeds, 83
data transferred, amount of

Mac, 111
Windows, 53

data usage, charges, 143
default connection (Windows), 50
definitions, glossary, 155

deleting Sprint Connection Manager, 59
deposits, 139
Device Info & Diagnostics (Windows), 77
"Device is Locked" message (Mac), 107
"Device Locked" message (Windows), 40
"Device Not Activated" window (Mac), 108
"Device powered off" message (Windows 

only), 40
diagnostics (Windows), 77
dial-up account, 84
dimensions, 123
direction, current (Windows only), 37
disclaimer

network coverage, 140
Sprint Location Services (Windows only), 

146
warranties, 147

Disconnect button (Mac), 110
"Disconnected" message

Mac, 107
Windows, 39

disconnected icon (Windows), 42
disconnecting

Mac, 110
Windows, 54

disk space required, 10
Display GPS Receiver (Windows only), 72
Display GPS Welcome (Windows only), 72
Display Location & Search Services on the 

menu (Windows only), 72
dispute resolution, 148
disputing charges, 145
Do not show NMEA Privacy Consent 

(Windows only), 72
Do not show Privacy Consent for Location & 

Search Services (Windows only), 72
document number, 128
dormant icon (Windows)

Mobile Broadband window, 35
system tray, 42

driver installation
Mac, 105
Windows, 22

drop test, 123
dropped connection

Mac, 114
Windows, 95

E
E911, 122
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early termination fee, 137
editing (Windows)

Sprint Connection Manager settings, 65
Sprint Power Vision/Sprint Vision 

connection, 68
electrical specifications, 121
electromagnetic emissions warning

Canada, 126
USA (FCC), 125

electronic serial number (ESN) (Windows), 
26

elevation information (Windows only), 73
EMI warning

Canada, 126
USA (FCC), 125

emissions, electromagnetic, warning
Canada, 126
USA (FCC), 125

Enable Location Services (Windows only), 72
Enable Network Adapter (NDIS) (Windows), 

69
encryption - required for IOTA (Windows), 

10
ending a connection

Mac, 110
Windows, 54

ending NMEA (Windows only), 91
enhanced Local Search (Windows only)

definition, 85
obtaining this feature, 85

environmental specifications, 123
error messages - viewing (Windows), 76
error, position (HEPE) (Windows only), 36
ESN (electronic serial number) (Windows), 

26
EV-DO. See 1X, 1xEV-DO.
exiting Sprint Connection Manager, 49
expanded view (Windows)

GPS Receiver window, 48
Mobile Broadband window, 47

expanding Sprint Connection Manager, 46
explosion risk if incorrect battery used

Mac, 105
Windows, 19

external antenna, attaching
Mac, 111
Windows, 43

F
FAQ (Frequently Asked Questions)

Mac, 114
Windows, 81

favorites (Windows), 58
fax, 122
FCC

compliance, 125
EMI warning, 125
ID, 125

fees
early termination, 137
government, 144
late, 144

firmware upgrades, 129
fix, last (Windows only), 37
forgot the lock code, 56
frequencies, transmit and receive, 121
frequency stability, 121
Frequently Asked Questions (FAQ)

Mac, 114
Windows, 81

G
General options in Settings window 

(Windows), 66
general terms and conditions of services, 

136
global positioning system (GPS) (Windows 

only). See GPS, Sprint Location Services, and 
also the FAQ chapter (Windows).

glossary, 155
GO automatically when ready (Windows), 

69
GO button (Windows)

GPS Receiver window, 38
Mobile Broadband window, 50
unavailable, 94

Google Maps (Windows), 72
government fees, 144
$GPGGA, 90
$GPGSA, 90
$GPGSV, 90
$GPRMC, 90
GPS (Windows only)

See also Sprint Location Services, and also 
the FAQ chapter (Windows).

accuracy, 36
application, 89, 90
Control Plane, 86
definition, 85
disclaimer, 146
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enable/disable, 72, 87
GPS Basic, 88
GPS Premium, 89
GPS Receiver window, 35
icon in system tray, 42
limitations, 88
Privacy, 87
subscription, 87
Test GPS, 73
User Plane, 86
where can I use it?, 86

GPS Basic (Windows only), 88
GPS Control Plane (Windows only), 86
GPS Port (Windows only), 37
GPS Premium (Windows only), 89
GPS Receiver window

compact view, 48
diagram with callouts, 35
expanded view, 48
icons, 36
show/hide, 72
text displayed in, 41

GPS status (Windows only)
icons, 36
text, 41

GPS Testing (Windows only), 73
GPS User Plane (Windows only), 86
GPSOne (Windows only), 88

H
hard drive space required, 10
hardware requirements, 10
hazards, 134
heading (Windows only), 37
headset jack, 123
Help

overview, 13
alert log (Windows), 76
contact number, 13
device info and diagnostics (Windows), 77
diagnostics (Windows), 77
frequently asked questions (FAQ) (Mac), 

114
frequently asked questions (FAQ) 

(Windows), 81
menu options (Mac), 111
menu options (Windows), 60
online Help (Windows only), 54
Sprint Customer Service, 13
Sprint.com, 13
tests (Windows), 77

troubleshooting (Mac), 113
troubleshooting (Windows), 92

HEPE (Horizontal Estimated Position Error) 
(Windows only), 36

hibernation mode (Windows), 84
high encryption (Windows), 10
history, connection (Windows), 75
Horizontal Estimated Position Error (HEPE) 

(Windows only), 36
hospital, powering the USB modem off in 

(Windows only), 45
humidity, 123

I
icons (Mac), 110
icons (Windows)

GPS Receiver window, 36
Mobile Broadband window, 34
system tray, 42

indemnification, 150
indicators (Mac), 110
indicators (Windows)

GPS Receiver window, 36
Mobile Broadband window, 34
system tray (Windows), 42

information, system (Windows), 77
initial lock code (Windows), 55
"Initializing" message (Windows), 39
inserting the USB modem

Mac, 106
Windows, 22

installation
overview, 8
installed files (Windows), 79
Mac, 102
Windows, 10

interference, 45
Internet Explorer, auto-launch (Windows), 

52
Internet Over The Air (Windows), 27
invoice, requesting a copy of, 13
IOTA 2.4 (One Touch Activation), 5, 25
IOTA (Internet Over The Air) (Windows)

"Unable to prepare data services" 
message, 97

description, 27
IOTA Provisioning window, 27
One Touch Activation (IOTA 2.4), 5, 25

K
Keep Connection History (Windows), 67
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knowledge base, 13

L
last fix (Windows only), 37
late fees, 144
latitude (Windows only), 36, 73
Launch when Windows starts, 67
LBS (Location-Based Services) (Windows 

only). See Sprint Location Services.
LEDs (lights), 120
liability, limitation of, 129
life support equipment — hazards warning, 

134
lights (LEDs), 120
Limitation of Liability, 129
limitations, Sprint Location Services 

(Windows only), 88
links, access (Windows), 58
Location & Search Services. See Sprint 

Location Services.
Location information (Windows only), 36
Location-Based Services (LBS) (Windows 

only). See Sprint Location Services.
lock code (Windows)

overview, 55
lock code - warning, 56
lock code (Windows)

changing, 58
initial lock code, 55

lock USB modem (Windows)
immediately, 56
upon startup, 57

locked USB modem (Mac), 111
locked USB modem (Windows)

behavior when the USB modem is locked, 
56

changing the lock code, 58
initial lock code, 55
unlocking the USB modem, 57

log (Windows)
alert, 76
connection, 75

longitude (Windows only), 36, 73
lost device, 146

M
Mac OS X

system requirements, 102
See also Watcher Lite.

maintenance, 6

making a connection (Mac)
connecting to the network, 110
amount of data transferred, 111
cannot connect, 114

making a connection (Windows)
1X or 1xEV-DO (Network Mode), 70
always on, 69
amount of data transferred, 53
application to automatically launch upon 

network connection, 52
automatically, 69
cannot connect, 95
connecting to the network, 50
Network Mode, 70

map services (Windows only), 72
Mapping and Search Service (Windows 

only), 72
MapQuest (Windows), 72
maps, coverage, 13
mechanical specifications, 123
medical equipment — hazards warning, 

134
MEID (Mobile Equipment IDentifier) 

(Windows), 26
memory required, 10
Menu (Windows)

all options, 60
About Sprint Mobile Broadband, 80
Alert Log, 76
Connection History, 75
Device Info & Diagnostics, 77
Exit, 54
Links, 58
Location & Search Services, 44
Menu button, 37
Settings, 65
Software Updates, 79
system tray menu, 63

Menu button (Windows only), 37
menu options (Mac), 111
menu options (Windows)

Location & Search Services menu, 44
Sprint Connection Manager menu, 60
system tray menu, 63

messages - viewing (Windows), 76
messaging, text (SMS), 122
Microsoft Live (Windows), 72
Microsoft VPN (PPTP) Connection 

(Windows), 52
minimizing Sprint Connection Manager
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immediately, 49
on startup, 67

minus sign (-) in Sprint Connection 
Manager, 46

miscellaneous charges, 142
Mobile Broadband window

description of icons, 34
diagram with callouts, 34
expanded view, 47

Mobile Equipment IDentifier (MEID) 
(Windows), 26

Mobile IP, 122
Mobile System ID (MSID)

Mac, 109
Windows, 26

MS-Based position location technology 
(Windows only), 88, 122

MSID (Mobile System ID)
Mac, 109
Windows, 26

N
NAM, 122
NDIS (Windows)

"Connected to NDIS" message, 40
Enable Network Adapter (NDIS), 69

network
 See Sprint network.

network adapter (NDIS) (Windows), 69
Network Mode (Windows), 69
Never Ask (Roam Guard) (Windows), 52
NMEA (Windows only)

configuring the port, 91
definition, 90
starting, 91
stopping, 91
when to use, 90

"No device" message (Windows), 38
"No device detected" message (Mac), 111
non-preactivated USB modem

Mac, 108
Windows, 25

non-preferred roaming area (Windows), 34
"Not activated" message (Mac), 108
notices

regulatory, 125
safety, 133

number of satellites (Windows only), 73

O
"OFF" message (Windows only), 41

on top, always (Windows), 67
One Touch Activation (IOTA 2.4), 5, 25
online Help (Windows only), 54
operating systems supported, 9
operating temperature, 123
optimizing performance, 84
OTAPA, 122
OTASP, 122

P
package contents, 6
patents, 127
payments, 144
performance, improving, 84
personal usage (Windows), 75
phone number (Windows)

during Activation Wizard, 26
Sprint Mobile Broadband USB modem, 55

phone number, transferring, 140
planes

hazards warning, 134
powering the USB modem off in 

(Windows only), 45
Play sound effects (Windows), 67
plus sign (+) in Sprint Connection Manager, 

46
port configuration (Windows), 77
porting/transferring phone numbers, 140
position error (HEPE) (Windows only), 36
position location (Windows only), 122

See also Sprint Location Services, and also 
the FAQ chapter (Windows).

power button, 123
powering the USB modem on and off 

(Windows only), 45
Power Vision, Sprint (1xEV-DO). See 1X, 

1xEV-DO.
power, transmitter, 121
powered off (Windows only), 40, 45
PPTP - Microsoft VPN (PPTP) Connection 

(Windows), 52
preactivated USB modem

Mac, 107
Windows, 24

preferred roaming list, 122
Preview Pane, 84
privacy (Windows)

Consent Agreement (Sprint Location 
Services), 72
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GPS not available, 87
icon (GPS Receiver window), 36

privacy, terms, 145
PRL, 122
problems, 92, 113
products, Sprint (Windows), 58
profile - data (Windows), 27
properties of connection, changing 

(Windows), 68
pro-rating charges, 142
provisioning

Mac, 107
Windows, 24, 27

"Provisioning failed" message (Mac), 108
PWR LED, 120

Q
questions. See troubleshooting.

R
radio frequency (RF) specifications, 121
receive frequencies, 121
Receiver, GPS (Windows)

compact view, 48
diagram with callouts, 35
expanded view, 48
icons, 36
show/hide, 72
text displayed in, 41

records of connection history (Windows), 75
regulatory

information, 124
notices, 125

Relock modem when program exits 
(Windows), 57

removing
hardware (Mac), 112
hardware (Windows), 22
software (Sprint Connection Manager), 59

report lost or stolen device, 146
report of system information (Windows), 79
requirements, system

Mac, 102
Windows, 9

resolution of disputes, 148
restoring Sprint Connection Manager, 49
restrictions on using services, 140
returning deposits, 139
RF (radio frequency) specifications, 121
Roam Guard (Windows), 51

Roam Mode (Windows), 70
Roam Only (roaming option) (Windows), 70
roaming

description, 4
display warning message (Windows), 51
indicator (Mac), 110
indicator (Windows), 34
PRL, 122
settings (Windows), 70

RSSI (signal strength)
Mac, 110
Windows, 34, 77

Running Diagnostics (Windows), 77

S
Safety and Hazards, 134
satellites (Windows only)

number of, 36, 73
status, 36

Search Services (Windows only). See Sprint 
Location Services.

"Searching for service" message
Mac, 113
Windows, 39, 94

security (Mac)
unlocking the USB modem, 107

security (Windows)
overview of user lock, 55
warning, 56
behavior when the USB modem is locked, 

56
changing the lock code, 58
high encryption - required for IOTA, 10
IOTA - high encryption requirement, 10
lock USB modem immediately, 56
lock USB modem upon startup, 57
unlocking the USB modem, 57

service
conditions of, 135
coverage, determining (Mac), 110
coverage, determining (Windows), 43
restrictions on using, 140
roaming indicator (Mac), 110
roaming indicator (Windows), 34
"Searching for service" message (Mac), 

113
"Searching for service" message 

(Windows), 94
service charges, 142
Service Packs, Windows, 9
service plan, adding options, 13
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services, Sprint (Windows), 58
Settings window (Windows)

overview, 65
General, 66
Sprint Location Services, 71
Sprint Mobile Broadband, 68

short text messaging (SMS), 122
shortcut menu (Windows), 63
show Welcome screens (Windows), 69
signal strength

diagnostic tests (Windows), 77
indicator (Mac), 110
indicator (Windows), 34

sleep mode (Mac), 120
SMS, 122
software (Mac)

components, 11
icons, 110
installing, 101
messages, 110

software (Windows)
components, 11
installing, 17
lock USB modem immediately, 56
lock USB modem upon startup, 57
menu options, 60
minimizing, 49
minimizing on startup, 67
removing, 59
restore minimized, 49
uninstalling, 59
unlocking the USB modem, 57
updating, 79
upgrading Windows, 97
user lock, 55
version information, 80
Windows, upgrading, 97

software specifications, 122
Software Updates (Windows), 79
sound effects, play (Windows), 67
specifications

environmental, 123
mechanical, 123
radio frequency and electrical, 121
software, 122

speed, current (Sprint Location Services) 
(Windows only), 36

speeds, data transmission, 83
Sprint (roaming option) (Windows), 70
Sprint Connection Manager

overview, 32

1X or 1xEV-DO connection (Network 
Mode), 70

About Sprint Mobile Broadband, 80
amount of data transferred, 53
application to automatically launch upon 

network connection, 52
automatically connecting when ready, 69
cannot connect, 95
closing, 49
configuring, 65
expanding Sprint Connection Manager, 

46
frequently asked questions (FAQ), 81
GPS Receiver window, 35
icons, 34
icons (GPS Receiver window), 36
icons (Mobile Broadband window), 34
icons (system tray), 42
links, 58
menu options, 60
minimizing, 49
minimizing on startup, 67
Mobile Broadband windowr, 34
Network Mode, 70
removing, 59
restoring, 49
security features, 55
settings, 65
Sprint Location Services, 43
starting, 32
starting automatically, 33
stopped working after Windows upgrade, 

97
system tray menu, 63
uninstalling, 59
updating, 79
upgrading Windows, 97
version information, 80
window overview, 33
Windows upgrade, 97

Sprint Connection Manager settings
1X or 1xEV-DO connection (Network 

Mode), 70
changing, 65
General, 66
Sprint Location Services, 71
Sprint Mobile Broadband, 68

Sprint Connection Manager stopped 
working after I’ve upgraded to a different 
version of Windows, 97

Sprint Customer Service, 13
Sprint Location Services (Windows only)
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See also GPS, and also the FAQ chapter 
(Windows).

definition of LBS (Location-Based 
Services), 84

disclaimer, 146
display Location & Search Services on the 

menu, 72
enable/disable, 72, 87
frequently asked questions, 85
GPS Receiver window, 35
icon in system tray, 42
icons, 36
limitations, 88
Location & Search Services menu, 44
Privacy, 87
settings, 71
subscription, 87
Test GPS, 73
text in GPS Receiver window, 41
troubleshooting, 96
using, 43

Sprint Mobile Broadband USB modem
inserting (Mac), 106
inserting (Windows), 22
phone number (Windows), 55
removing (Mac), 112
removing (Windows), 22

Sprint network
1X or 1xEV-DO connection (Network 

Mode) (Windows), 70
always on connection (Windows), 69
amount of data transferred (Mac), 111
amount of data transferred (Windows), 

53
application to automatically launch upon 

network connection (Windows), 52
automatically connecting when ready 

(Windows), 69
availability status (Windows), 77
cannot connect (Mac), 114
cannot connect (Windows), 95
CDMA wireless network, description, 4
connecting (Mac), 110
connecting (Windows), 50
coverage, determining (Mac), 110
coverage, determining (Windows), 43
coverage, disclaimer, 140
frequently asked questions (FAQ) (Mac), 

114
frequently asked questions (FAQ) 

(Windows), 81
roaming indicator (Mac), 110

roaming indicator (Windows), 34
roaming options (Windows), 70
signal strength indicator (Mac), 110
signal strength indicator (Windows), 34
Sprint Location Services (Windows only), 

43
Sprint Power Vision (1xEV-DO). See 1X, 

1xEV-DO.
Sprint products and services (Windows), 58
Sprint roaming (Windows), 70
Sprint Vision

1X or 1xEV-DO connection (Network 
Mode) (Windows), 70

Always show Welcome screens 
(Windows), 69

amount of data transferred (Mac), 111
amount of data transferred (Windows), 

53
application to automatically launch upon 

network connection (Windows), 52
automatically connecting when ready 

(Windows), 69
cannot connect (Mac), 114
cannot connect (Windows), 95
connecting (Mac), 110
connecting (Windows), 50
coverage, determining (Mac), 110
coverage, determining (Windows), 43
disconnecting (Mac), 110
disconnecting (Windows), 54
ending a connection (Mac), 110
ending a connection (Windows), 54
Network Mode (Windows), 70
settings (Windows), 68
warning when roaming (Windows), 51
See also 1X, 1xEV-DO.

Sprint Web site, 13
Sprint, contacting, 13
sprint.com, 13
standby current, 121
Start in system tray (Windows), 67
starting a connection (Mac), 110
starting a connection (Windows)

application to automatically launch upon 
network connection, 52

automatically connecting when ready, 69
immediately, 50
specify 1X or 1xEV-DO connection 

(Network Mode), 70
warning when roaming, 51

starting NMEA (Windows only), 91
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starting Sprint Connection Manager
automatically, 33
manually, 32

status information (Windows), 77
status of connection (Mac), 110
status of connection (Windows)

GPS Receiver window, 41
Mobile Broadband window, 38
system tray, 42

stolen device, 146
Stop button (Windows)

GPS Receiver window, 38
Mobile Broadband window, 54

stopping NMEA (Windows only), 91
storage temperature, 123
subscriber agreement, 136
subscription, GPS (Windows only), 87
support, 13
surcharges, 144
suspend mode (Windows), 120
system information (Windows), 77, 79
System Parameters (Windows), 79
system requirements

Mac, 102
Windows, 9

system tray (Windows)
connection states, 42
icons, 42
menu, 63
shortcut menu, 63
start in, 67

T
taskbar icon (Windows)

shortcut menu, 49
taxes, 144
technical specifications, 119
technical support, 13
telephone number of USB modem 

(Windows), 55
temperature (operating, and storage), 123
termination fee, 137
Terms and Conditions, 135
terms and definitions (glossary), 155
Test GPS (Windows only), 73
tests, diagnostic (Windows), 77
text messaging (SMS), 122
trademarks, 128
transferred data, amount of

Mac, 111

Windows, 53
transferring phone numbers, 140
transmission speeds, 83
transmit frequencies, 121
transmit/receive icon (Windows), 34, 35
transmitter power, 121
trilateration (Windows only), 88
troubleshooting (Mac)

common causes of problems, 113
Connect button is unavailable, 113
contact information, 13
frequently asked questions (FAQ), 114
"Searching for service" message, 113

troubleshooting (Windows)
common causes of problems, 93
alert log, 76
cannot connect, 95
contact information, 13
"Could not prepare data services" 

message, 97
frequently asked questions (FAQ), 81
GO button is unavailable, 94
run diagnostic tests, 77
"Searching for service" message, 94
Sprint Connection Manager stopped 

working after Windows upgrade, 97
Sprint Location Services, 96
Troubleshooting wizard, 13
"Unable to prepare data services" 

message, 97
wizard, 13

Troubleshooting wizard (Windows), 13
TTY, 122
type of coverage, determining

Mac, 110
Windows, 43

U
uninstalling Sprint Connection Manager, 59
unlocking the USB modem (Mac), 107
unlocking the USB modem (Windows)

initial lock code, 55
instructions, 57

Update Data Profile (Windows), 27
updates, checking for latest, 129
updating the software (Windows), 79
"Updating User Profile…" message

Mac, 108, 109
Windows, 27

upgrading Windows, 97
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URL to automatically launch upon network 
connection (Windows), 52

URLs - favorites (Windows), 58
USB modem, powering off (Windows only), 

45
USB port (Windows), 77
user lock (Mac)

unlocking the USB modem, 107
user lock (Windows)

overview, 55
warning, 56
changing the lock code, 58
lock USB modem immediately, 56
lock USB modem upon startup, 57
unlocking the USB modem, 57

User Lock Change button (Windows), 70
User Plane, GPS (Windows only), 86

V
"Validating" message (Windows), 41
vehicle, operating

hazards warning, 134
version information (Windows), 80
version of this document, 128
vibration, 123
views of Sprint Connection Manager, 46
Vision. See Sprint Vision, and 1X, 1xEV-DO.
Vista, Windows, 9
voice support, 122
voltage, 121
VPN (Mac)

accessing your corporate network 
through a VPN, 115

VPN (Windows)
accessing your corporate network 

through a VPN, 84
specifying a VPN program to 

automatically launch upon network 
connection, 52

W
warning

electromagnetic emissions (EMI) — 
Canada, 126

electromagnetic emissions (EMI) — USA 
(FCC), 125

explosion risk if incorrect battery used 
(Mac), 105

explosion risk if incorrect battery used 
(Windows), 19

lock code, regarding, 56

roaming, display message (Windows), 51
warranties, disclaimer of, 147
warranty, 6
Watcher Lite

frequently asked questions (FAQ), 114
icons, 110
installing, 101
messages, 110
troubleshooting, 113

weak signal
Mac, 113
Windows, 94

Web site - Sprint.com, 13
Web site (Windows)

automatically launch upon network 
connection, 52

favorites, 58
Welcome screen, always show (Windows), 

69
Windows

auto-launch Sprint Connection Manager, 
67

upgrading, 97
versions supported, 9

Wireless Local Number Portability (WLNP)
Mac, 109
Windows, 26

wizard (Mac) - Activation Assistant, 108
wizard (Windows)

Activation Wizard, 24
Troubleshooting, 13

WLNP (Wireless Local Number Portability)
Mac, 109
Windows, 26

www.sprint.com, 13

X
XP, Windows, 9

Y
Yahoo! Maps (Windows), 72
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